
(For 9th Class)

Computer Science

Punjab School Education Board 
Sahibzada Ajit Singh Nagar 

ieh pusqk pMjwb srkwr duAwrw mu&q id~qI
jwxI hY Aqy ivkwaU nhIN hY[



WARNING

1. The Agency-holders shall not add any extra binding with a view to charge extra 
money for the binding. (Ref. Cl. No. 7 of agreement with Agency-holders).

2. Printing, Publishing, Stocking, Holding or Selling etc., of spurious Text-books qua 
text books printed and published by the Punjab School Education Board is a 
cognizable offence under Indian Penal Code.

 (The textbooks of the Punjab School Education Board are printed on paper carrying 
water mark of the Board.)

All rights, including those of translation, reproduction
and annotation etc., Are reserved by the

Punjab Government

Third Edition 2020 
Fourth Edition 2021 .............................. 27,700 Copies

© Punjab Government

VETTER 
Govt. Model Sen. Sec. School, Phase 3B1, MohaliS. Gagandeep Singh, 

CO-ORDINATOR
S. Manvinder Singh, Punjab School Education Board

ieh pusqk ivkrI leI nhIN hY[

Vishal Quality Printers, Jalandhar.



Chairman
Punjab School Education Board

‘smwijk inAW, AiDkwrqw Aqy G~t igxqI ivfwg’ pMjwb



Contents 
Pages No.Lesson

For any types of Suggestions regarding this book, 
Please mail to subjectexpert@pseb.ac.in



Objective of this Lesson
1.1 Formatting Cells

 1.1.1 Merge and Centre

 1.1.2 Styles

  1.1.2.1 Conditional Formatting

  1.1.2.2 Formatting as Table

  1.1.2.3 Cell Styles

1.2 Cells

1.3 Editing

 1.3.1 Formulas & Functions

  1.3.1.1 Auto Sum-Functions (Sigma)  

 1.3.2 Sorting & Filters

 1.3.3 Find & Replace

Introduction
We know that Microsoft Excel is used to calculate mathematical and scientific 

calculations. An Excel Workbook consists of many worksheets that are used to 

perform these calculations. A worksheet is made up of Rows and columns. 

Intersection of a Row and Column generate a cell. 

1.1 Formatting Cells
Each cell in a worksheet can be formatted with many properties. Changing the 

format of a cell doesn't affect the cell value that Excel uses when performing 

calculations. For example, we have a cell that is formatted to display a number with 

no decimal points. But, if that cell content is a mathematical formula of division, the 

actual cell value can have many decimal points.

There are six tabs in the "Format Cells" window, and all formatting options may 

be found on one of these tabs. Multiple cells can be formatted in one step by first 

selecting the cells and applying formatting as per your choice.

The "Format Cells" window can be opened in from the right-click menu. In Excel 

formatting options are available on the Home Tab on the Font, Alignment, and 
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Number groups. To see formatting options not displayed, click the little arrow 

(called launcher) in the lower right corner of the group and the "Format Cells" 

window displays as shown in fig. 1.1

Fig. 1.1 

1.1.1 Merge and Centre

Merging cells is often used when a title is to be centered over a particular section 

of a spreadsheet. When a group of cells is merged, then the text of this cell is merged 

as per selection and aligned center. Let's see how to do this :

Fig. 1.2 

To merge a group of cells : Following are the steps :

1. Type your data as shown in fig. 1.2 in your worksheet.

2. Highlight or select a range of cells.

3. Right-click on the highlighted cells and select Format Cells. Format Cells 

dialog box will open see in fig. 1.3.

4. Click the Alignment tab of Format Cells dialog box and place a checkmark in 

the checkbox labeled Merge cells as shown in fig. below :
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Fig 1.5

To merge a group of cells and center the text, we can also use the Merge and 

Center button on the Excel tool bar. Let's study about this :

Steps : 

1. Highlight or select a range of cells. Click the Merge and Center button on the 

toolbar as shown in fig 1.6

Fig. 1.6

Clicking this button will automatically merge our highlighted cells and center the 

cell value.

Fig 1.3    Fig 1.4
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1.1.2 Styles in MS Excel

A style is just a set of cell formatting settings it is named such as conditional 

formatting. All cells to which a style has been applied look the same according to 

formatting. When you change a part of a style, all cells to which that style has been 

applied also change their formatting accordingly to new style.

Fig. 1.7

1.1.2.1 Conditional Formatting

 Conditional Formatting is a tool in MS Excel that allows applying formats to a 

cell or range of cells. It also allows formatting change depending on the value of the 

cell or the value of a formula. For example, you can have a cell appear bold only 

when the value of the cell is greater than 100. Conditional formatting in Excel enables 

you to highlight cells with a certain color, depending on the cell's value.

Conditional formatting applies one or more rules to any cells we want. For 

example we want to apply a rule if the cell value is greater than 80 then color the cell 

Red. By applying this rule to the cells in a worksheet, we'll be able to see which cells 

are more than 80. 

How to create a conditional formatting rule : If we want to highlight the cells 

having value move then desired value. We can use conditional formatting in the 

following example we will set the cell value more than 80 using conditional 

formatting.

Highlight Cells Rules : To highlight cells that is greater than a value. Steps are as 

follow :

1. Type the data in our worksheet as shown in fig. 1.8 below.

2. Select the range A1:A10.
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3. Now go to Home Tab as shown in fig 1.9  click Conditional Formatting Ù�

Highlight Cells Rules Ù Greater Than

Fig. 1.9

4. Enter the desired value 80 and select a formatting style as shown in fig. 1.10

Fig. 1.10

5. Click on OK

 Now Excel will highlight the cells with Red color that are greater than 80.

Fig. 1.11
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1.1.2.2 Formatting as Table

Once we have entered information into a spreadsheet, we can format it. 

Formatting can not only improve the look of your spreadsheet, but it also can make it 

easier to use. 

Fig. 1.12

Just like regular formatting, tables can help to organize our content and make it 

easier for us tofind the information we need. To use tables effectively, we'll need to 

know how to format information as a table, modify tables, and apply table styles. 

To format information as a table :

1. Type the data in worksheet as shown in the fig. 1.13 below.

2. Select the cells we want to format as a table. In this example, an invoice, we'll 

format the cells containing the column headers and order details.

Fig. 1.13

6



3. Click the Format as Table command in the Styles group on the Home tab.

Fig. 1.14

4. A list of predefined table styles will appear as shown in fig. 1.15 . Click a table 
style to select it. 

Fig. 1.15

5. A dialog box will appear as per fig 1.16 confirming the range of cells we have 
selected for our table. The cells will appear selected in the spreadsheet and the 
range will appear in the dialog box.

6. If necessary, change the range by selecting a new range of cells directly on 
your spreadsheet.

7. If our table has headers check the box next to My table has headers as shown 
in fig. 1.16 below. 

Fig. 1.16
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8. Click OK. The data will be formatted as a table in the style we chose as shown 

in fig. 1.17.

Fig. 1.17

* Tables include filtering by default. We can filter our data at any time using the 

drop-down arrows in the header. 

1.1.2.3 Cell Styles

When we want to format cells in Microsoft Excel, we can do it manually either by 

selecting fonts, font color and size, background colors and borders, or we can do the 

formatting quickly and automatically using styles. 

Microsoft Office Excel has several built-in cell styles that we can apply or modify. 

We can also modify or duplicate a cell style to create our own such as custom cell 

style.

Cell styles are based on the document theme that is applied to the whole 

workbook. When you switch to another document theme, the cell styles are updated 

to match the new document theme.

Applying a cell style :

1. Type the data in our worksheet as show in fig. 1.17

2. Select the cells that we want to format.

3. On the Home tab, in the Styles group, click Cell Styles.

Fig. 1.18
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* If we do not see the Cell Styles button, click Styles, and then click the more 

buttons  next to the cell styles box as shown in fig. 1.19

Fig. 1.19

4. Click the cell style that we want to apply. Our data will be changed according 

to our selected style.

1.2 Cell Group
If we need to add new data within an existing worksheet we need to enter blank 

cells. So we can insert new cells, columns, or rows in the worksheet.

To insert new cells, rows, or columns in an Excel worksheet, follow these steps :

1. Select the cells, rows, or columns where we want the new blank cells to 

appear.

Fig 1.20
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2. Click the drop-down arrow attached to the Insert button in the Cells group of 

the Home tab.

Fig. 1.21

3. Click Insert Cells on the drop-down menu as show in fig. 1.22.

Fig. 1.22

The Insert dialog box opens with the following options:

å Shift Cells Right : It shifts existing cells to the right to make room for the 

blank cells you want to insert.

å Shift Cells Down : It instructs Excel to shift existing cells down. This is the 

default option.

å Entire Row :  It inserts complete rows in the cell range. We can also select the 

row number on the frame before we choose the Insert command.

å Entire Column : It inserts complete columns in the cell range. We can also 

select the column letter on the frame before we choose the Insert command.

Shortcut Method :

å To quickly insert an entire column or row into the worksheet, we can right-

click the column letter such as A, B, C, D or row number such as 1, 2, 3, 4 on 

the worksheet window frame and then select Insert from the shortcut menu 

å We should keep in mind that inserting entire columns and rows affects the 

entire worksheet, not just the part we see. 
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Deleting cells, rows, or columns

If some of the cells/rows/columns are not necessary we can delete it easily. We 

can delete a cell structure along with all its contents and formatting. When we delete 

a cell (or an entire row or column), Excel has to shuffle the position of entries in the 

surrounding cells to plug up any gaps caused by the deletion.

To delete the actual cell selection rather than just clear the cell contents, follow 

these steps :

1. Type data in our worksheet as shown in fig. 1.23.

2. Select the cells, rows, or columns we want to delete.

Fig. 1.23

3. Click the drop-down button attached to the Delete button in the Cells group of 

the Home tab as shown in fig. 1.24

4. Click Delete Cells on the drop-down menu.

Fig 1.24

The Delete dialog box opens, showing these options for filling in the gaps:
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Fig. 1.25

å Shift Cells Left : It moves entries from neighboring columns on the right to 

the left to fill in gaps created when we delete the cell selection. This is the 

default option.

å Shift Cells Up :  It moves entries up from neighboring rows below.

å Entire Row : It  removes all the rows in the current cell selection.

å Entire Column : It deletes all the columns in the current cell selection.

Shortcut Method :

å If we want to quickly delete an entire column or row from the worksheet, we 

can right-click the column or row label and select Delete from the shortcut 

menu 

å By deleting entire columns and rows from a worksheet is risky unless we're 

sure that the columns and rows contain no value.

How to Insert New Worksheets ?

As we can add new cells/row/columns in our existing worksheet, we can also 

add a new worksheet in our current workbook. For this click the Insert Worksheet 

icon as shown in fig. 1.26 below. A new worksheet will appear.

Fig. 1.26

We can change the setting for the default number of worksheets that appear in 

Excel workbooks. To do this click on the worksheet we want to keep in arrange. Now 
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keep pressing the left button of our mouse and drag that worksheet to desired 

location, release the mouse button when its done.

How To Delete Worksheets/worksheet ?

A Single Worksheet or Worksheets can be deleted from a workbook, including 

those containing data. Following are the steps for this:

1. Select the worksheet/worksheets we want to delete.

2. Right-click one of the selected worksheets. The worksheet menu appears as 

shown in fig. 1.27

3. Select Delete. The selected worksheets will be deleted from our workbook.

Fig 1.27

Cell Size : When we open a new blank workbook, the cells are set to a default 

size. We can modify size of cells according to our requirement. We will learn how to 

change row height and column width.

Fig. 1.28
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Working with columns, rows, and cells : By default, every row and column of a 

new workbook is set to the same height and width. We can modify column width 

and row height in different ways in Excel.

How to modify column width ?

1. Place our mouse over the column line in the column heading so the white 

cross      becomes a double arrow       as shown in fig. 1.29

Fig. 1.29

2. Click and drag the column to the right to increase column width or to the left 

to decrease column width as shown in fig. 1.30

Fig. 1.30
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3. Release the mouse. The column width will be changed in your spreadsheet as 

shown in fig. 1.31

Fig 1.31

* When we have entered data in a cell and If you see Hash signs (#######) in a 
cell, it means that. the column size is not fit enough to display the cell content. 
Simply in crease the column width to adjust the cell content.

How to set column width with a specific measurement ?

1. Select the columns we want to modify.
2. Click the Format command on the Home tab. The format drop-down menu 

appears.
3. Select Column Width.

Fig. 1.32
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4. The Column Width dialog box appears. Enter our specific measurement.

Fig 1.33

5. Click OK. The width of each selected column will be changed in our 

worksheet.

* Select AutoFit Column Width from the format drop-down menu and Excel 

will automatically adjust each selected column so all of the text will fit.

How to modify row height ?

1. Place the cursor over the row line so the white cross     becomes a double 

arrow        as shown in fig. 1.34

Fig. 1.34

2. Click and drag the row downward to increase row height or upward to 

decrease height as shown in fig. 1.35

Fig 1.35
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3. Release the mouse. The height of each selected row will be changed in our 

worksheet as shown in fig. 1.36

Fig. 1.36

How to set row height with a specific measurement ?

1. Select the rows we want to modify.

2. Click the Format command on the Home tab. The format drop-down menu 

appears.

3. Select Row Height.

Fig 1.37
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4. The Row Height dialog box appears. Enter a specific measurement.

Fig. 1.38

5. Click OK. The selected rows heights will be changed in your spreadsheet.

* Select AutoFit Row Height from the format drop-down menu and Excel will 
automatically adjust each selected row so all of the text will fit.

1.3 EDITING
1.3.1 Formulas & Functions

We know that Excel is used to calculate numerical information. In this part, we 
will learn how to create simple formulas in Excel to add, subtract, multiply, and 
divide values in a workbook.

We will also learn how to make a formula easy and effective by using Cell 
reference.

To maximize the capabilities of Excel, it is important to understand how to create 
simple formulas.

Creating simple formulas :

Excel uses standard operators for equations, such as a plus sign for addition (+), 
minus sign for subtraction (-), asterisk for multiplication (*), forward slash for 
division (/), and caret (^) for exponents.

The key thing to remember when writing formulas for Excel is that all formulas 
must begin with an equals sign (=). 

To create a simple formula in Excel :

1. Select the cell where the answer will appear ( for exampleF3).

Fig 1.39

2. Type the equals sign (=).
18



3. Type in the formula we want Excel to calculate (85+87, for example).

Fig. 1.40

4. Press Enter. The formula will be calculated, and the value will be displayed in 

the cell.

Fig. 1.41

Creating formulas with cell references : When a formula contains a cell address, 

it is called a cell reference. Creating a formula with cell references is useful because 

you can update data in our worksheet without having to rewrite the values in the 

formula. Let's learn how to create a formula using cell reference :

To create a formula using cell references :

1. Select the cell where the answer will appear (for example F3).

2. Type the equals sign (=).

19



3. Type the cell address that contains the first number in the equation (for 

example D3).

Fig 1.42

4. Type the operator we need for our formula. For example, type the addition 

sign (+).

5. Type the cell address that contains the second number in the equation (for 

example E3).

Fig. 1.43

6. Press Enter. The formula will be calculated, and the value will be displayed in 

the cell.

Fig. 1.44
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* If you change a value in either D3 or E3, the total will automatically 

recalculate.

Fig. 1.45

To Edit a Formula : A formula in excel can be edited as per requirement, but 

while doing so, the calculated anser will be reflected too. Step are :

1. Click the cell we want to edit.

2. Insert the cursor in the formula bar as shown in fig. 1.46 and edit the formula 

as desired. We can also double-click the cell to view and edit the formula 

directly from the cell or press F2 key.

3. When we're done, press Enter or select the Enter command        .

Fig. 1.46
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4. The new value will be displayed in the cell G3.

Fig. 1.47

* If we want to cancel the changes made, use the Cancel command      in the 

formula bar.

Cell Reference : Cell Reference is very important in Excel. In Excel, Cell Reference 

is termed to calculate important calculations by using a cell or a range of cells for a 

formula to calculate the result of the formula in a worksheet. We can use a cell 

reference for a single formula or for multiple formulas. Let's learn about it in detail :

Types of Cell Reference :

1. Relative Reference.

2. Absolute Reference.

3. Mixed Reference.

Relative Reference : In Excel Relative reference is used by default. When it is 

copied to multiple cells then it changes according to cell position. For example : If we 

want to calculate a formula in cell C1=A1+B1 and we copy it to cell C2 then it 

becomes=A2+B2. Let's study it by using following example :

Fig 1.48

1. Type data in a worksheet as shown in fig. 1.48

2. Now type our formula in cell C1=A1+B1
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3. Drag the fill handle of cell C1 as shown in fig. 1.49, we will see that the 

formula becomes in cell C2=A2+B2.

Fig. 1.49

Absolute Reference : Sometimes we want that during copying a formula from 

one cell to another, its cell reference should not be changed. So, in this case Absolute 

Reference is used, in this type of reference the cell address doesn't change even 

during copying a formula. Using this reference we can keep a row/column constant. 

Dollar($) sign is used during typing a formula using Absolute Reference. Dollar($) 

sign can be used either for a row or a column. We can also use it for both together. 

Let's make it clear while using the following example :

Fig. 1.50

1. Type data in a worksheet as shown in fig 1.49

2. Now type our formula in cell C1=$A$1+B1

3. Drag the fill handle of cell C1 as shown in fig. 1.50, we will see that the 

formula becomes in cell C2=$A$1+B2. We will notice that cell address in 

formula remain constant as C2=$A$1.

 Fig 1.51
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Mixed Reference : Mixed Reference is the combination of both Relative and 

Absolute Reference. In Mixed Reference a Dollar($) sign is used either to a Row or 

Column. Let's make it clear while using the following example :

 Fig. 1.52

1. Type data in a worksheet as shown in fig 1.52

2. Now type our formula in cell C1=A1+B$1

3. Drag the fill handle of cell C1 as shown in fig. 1.53, we will see that the 

formula becomes in cell C2=A2+B$1. We will notice that cell address in 

formula has changed in cell C2 to A2 which is an example of Relative Cell and 

B$1 remains constant, is an example of Absolute Reference.

 Fig 1.53

Basic functions : A function is a predefined formula that performs calculations 

using specific values in a particular order. One of the key benefits of functions is that 

they can save our time because we do not have to write the formula yourself. Excel 

has hundreds of functions to assist with our calculations.

To use these functions correctly, we need to understand the different parts of a 

function and how to create arguments in functions to calculate values and cell 

references.
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The parts of a function : The order in which we insert a function is important. 

Each function has a specific order – called syntax – which must be followed in order 

for the function to work correctly. Sequence of a function can be learnt as follows :

1. First of all equal to (=) sign is written.

2. After this the function name is written (SUM, for example, if we want to add 

two numbers)

3. After this argument is written. Arguments contain the information we want 

the formula to calculate, such as a range of cell references.

Fig. 1.54

Working with arguments : Arguments are a vital part of a Function. So while 

writing Arguments for a functions, following point are taken care :

1. Arguments must be enclosed in parentheses for example ( ).

2. If there are Individual values or cell references inside the parentheses are 

separated by either colons or commas. Commas separate individual values, 

cell references, and cell ranges in parentheses. If there is more than one 

argument, we must separate each argument by a comma. 

 For example, =COUNT(A1:A5,B1:B5,C1:C5) 

3. If there is a cell range in argument then it is written with colon in braces, 

Colons create a reference to a range of cells. 

 For example, =AVERAGE(E19:E23)

To create a basic function in Excel :

1. Select the cell where the answer will appear (J3, for example).

2. Type the equals sign (=), then enter the function name (SUM, for example).
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Fig 1.55

3. Enter the cells for the argument inside the parentheses.

Fig. 1.56

4. Press Enter, and the result will appear.

 Excel will not always tell us if our function contains an error, so it's up to you 

to check all of our functions. 

1.3.1.1 Using AutoSum to select common functions

The AutoSum command allows us to automatically return the results for a range 

of cells for common functions like SUM and AVERAGE.

1. Select the cell where the answer will appear (J3, for example).

2. Click the Home tab.

3. In the Editing group, click the AutoSum drop-down arrow and select the 

function we want (Count Numbers, for example).

Fig. 1.57
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4. A formula will appear in J3, the selected cell. If logically placed, AutoSum will 

select our cells for us. Otherwise, we will need to click the cells to choose the 

argument we want.

Fig 1.58

5. Press Enter, and the result will appear.

* The AutoSum command can also be accessed from the Formulas tab.

1.3.2 What is Sorting ?

Sorting data in Excel basically means that we can arrange the data according to 

some specific criteria like for example, the numbers in ascending or descending order 

or ascending order according to the dates. We can even arrange data alphabetically. 

To sort data, follow these steps :

To sort in alphabetical order :

1. Type data in our worksheet as shown in Fig. 1.59

2. Select a cell in the column we want to sort by. In this example, we'll sort by 

Last Name.

Fig. 1.59
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Fig. 1.60

3. Select the Data tab, then locate the Sort and Filter group.

4. Click the ascending command to Sort A to Z or the descending command 

to Sort Z to A as shown in fig. 1.61

Fig. 1.61

5. The data in the spreadsheet will be organized alphabetically as shown in                       

       fig. 1.62
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Fig. 1.62

* Sorting options can also be found on the Home tab, condensed into the Sort & 
Filter command.

Filtering data : Filter is a tool in MS Excel that is used to get the information 
according to our requirement. When we need to find special information from a list, 
then we use Filter. Filters can be applied in different ways to improve the 
performance of our worksheet. We can filter text, dates, and numbers. We can even 
use more than one filter to further narrow our results.

How to filter data : In this example, we'll filter the contents of a shopkeeper. We'll 
display only the Tea and Oil commodities that are delivered. Let's study how to do 
this :

Steps :

1. Type the data in a worksheet as shown in the fig. 1.63 below :

Fig. 1.63
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2. Select the Data tab, and then locate the Sort & Filter group.

3. Click the Filter command.

Fig 1.64

4. Drop-down arrows will appear in the header of each column.

5. Click the drop-down arrow for the column we want to filter. In this example, 

we'll filter the Type column to view only certain types of commodities.

Fig. 1.65

6. The Filter menu appears.

7. Uncheck the boxes next to the data we don't want to view, or uncheck the box 

next to Select All to quickly uncheck all.

8. Check the boxes next to the data we do want to view. In this example, we'll 

check Tea and Oil to view only these types of commodities.
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Fig. 1.66

9. Click OK. All other data will be filtered, or temporarily hidden. Only Tea and 

Oil will be visible.

Fig. 1.67

* Filtering options can also be found on the Home tab, condensed into the Sort 

& Filter command.

To clear a filter : We can clear a filter very easily. To do so, following are the step : 

1. Click the drop-down arrow in the column from which we want to clear the 

filter.

2. Choose Clear Filter From.
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Fig 1.68

3. The filter will be cleared from the column. The data that was previously 

hidden will be on display once again.

* To instantly clear all filters from our worksheet, click the Filter command on 

the Data tab.

1.3.3 Find and Replace

Excel Find and Replace feature are powerful tools that we can use for special 

criteria such as to Find a text and to Replace it with our new text. We can narrow the 

search results by specifying formatting to look for as well as other search options, 

including Match Case.

How to use Find Option : Following are the steps to locate data in a worksheet :

1. Choose Find & Select in the Editing group on the Home tab, and then select 

Find (or press Ctrl+F).The Find and Replace dialog box appears with the Find 

tab on top.

                       Fig 1.69                  Fig 1.70
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2. In the Find What box, enter the data we want to locate as shown in fig. 1.79.

Fig 1.71

Click the Options button to expand the dialog box and specify any desired 

options.

å Within : It searches just the current worksheet or the entire workbook.

å Search : It selects whether to search first across the rows or down the columns.

å Look In : It selects whether we want to search through the values or formula 

results, through the actual formulas, or if we want to look in the comments.

å Match Case : It checks this box if we want our search to be case-specific.

å Match Entire Cell Contents: It checks this box if we want our search results to 

list only the items that exactly match our search criteria.

Fig 1.72

3. Click Find Next.

Excel jumps to the first occurrence of the match. If this is not the entry we're 

looking for, click Find Next again.

Click Close when we've located the entry we want.
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Using Replacing data Option : Replace option is used to change data according 

to our requirement. We can change each entry of a cell while typing on, but it require 

more time and labour so we can do it easily using Replace option. To find and 

replace data in a worksheet, follow these steps :

1. Choose Find & Select in the Editing group on the Home tab, and then select 

Replace (or press Ctrl+H).The Find and Replace dialog box appears with the 

Replace tab on top.

                         Fig 1.73                                                                              Fig 1.74

2. In the Find What box, enter the data we want to locate.

3. In the Replace With box, enter the data with which we want to replace the 

found data.

Fig 1.75

4. Click the Options button and specify any desired options.

5. Click Find Next to locate the first occurrence or click Find All to display a list 

of all occurrences.
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 We can sort the results of a Find All search by clicking a column heading.

6. If we want to use the replacement data, click Replace.

 Excel performs the replacement and locates the next occurrence.

7. If we want to replace all occurrences at the same time, click Replace All.

 Excel displays an information box indicating the number of replacements 

made.

8. Click OK in the alert box and then click Close.

Things to Remember
1. Microsoft Excel is used to calculate mathematical and scientific calculations.

2. By applying different number formats, we can change the appearance of a 

number without changing the number itself.

3. Formatting can not only improve the look of our spreadsheet, but it also can 

make it easier to use.

4. If we need to add new data within an existing worksheet, we can insert new 

cells, columns, or rows in the worksheet.

5. Worksheets can be deleted from a workbook, including those containing data.

6. A formula is an equation that performs a calculation.

7. When a formula contains a cell address, it is called a cell reference.

8. A function is a predefined formula that performs calculations using specific 

values in a particular order.

9. Each function has a specific order called syntax

10. Sorting data in Excel basically means that we can arrange the data according 

to some specific criteria.

Exercise
1. Fill in the Blanks : 

 1. An Excel Workbook consists of .......................... .

  (a) Worksheets (b) Rows (c) Columns (d) Formulas

 2. The actual value of a cell is displayed in .......................... bar.

  (a) Title (b)  Menu (c) Formula (d) None of these



 3. .......................... Formatting applies one or more rules to any cells we want.

  (a) Formula (b) Function (c) Conditional (d) None of these

 4. Format Command is available on .......................... Tab.

  (a) Home (b) Insert (c) Data (d) Formulas

 5. All Formulas must begin with an .......................... sign.

  (a) Sigma (b) Plus (c) Equal (d) None of these

 6. A data in our worksheet can be arranged in an order using .......................... .

  (a) Formula (b) Function (c) Filter (d) Sorting

 7. Sort & Filter command is available on .......................... Tab.

  (a) Home (b) Insert (c) Data (d) Formulas

2. Short Answer Type Questions : 

1. What is conditional Formatting ?

2. What is Merge & Centre ? .

3. Write different types of cell reference ?  

4. Define Sorting.

5. Define Filter.

3. Long Answer Type Questions :

 1. What is a cell ? How can we insert a new cell in our current worksheet ?

 2. What is a Formula ? Write down the steps to create a simple Formula in Excel.

 3. What is a Function ? Write different parts of function ?

4. True/ False 

 1. A function is a predefined formula.

 2. Sign X  is used to do Multiply. 

 3. A formula is equation that performs a calculation. 

 4. Each function has a specific order called Syntax. 

 5.  Filter is used to find special information from list. 
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Objective of this Lesson
2.1 Charts

 2.1.1 Inserting Charts

2.2 Data Tools

  2.2.1 Text to Columns

  2.2.2 Data Validation  

2.3 Protection

 2.3.1 Protect Sheet

 2.3.2 Protect Workbook

2.4 View Tab

 2.4.1 Split

 2.4.2 Freeze

 2.4.3 Hide and Unhide

Introduction

A chart is a tool in MS Excel that is used to communicate our data graphically. A 

chart can allow us to know the meaning behind our data. We can use these charts to 

make comparisons much easier. 

2.1 Charts
An Excel workbook can contain a large amount of data. So it is difficult for us to 

interpret this data. For example if we have numbers in our worksheet and we want 

to know the highest and lowest numbers from these numbers. So we can do it clearly 

by representing this data as a chart. Excel has various types of charts, so we can 

choose one that most effectively represents our data.

2.1.1 Types of Chart

å Pie Chart

å Column Chart
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å Line Chart

å Bar Chart

å Area Chart

å Scatter Chart etc.

2.1.2 How to create a Chart?

In this part we will learn how to create a chart. It is very easy to create a chart. 

Before making a chart first of all we need to define a data series. A data series is a 

related set of data points. In an Excel worksheet it is usually one row of data with the 

associated column headings or one column of data with the associated row headings. 

All chart types can plot both single and multiple data series except Pie Chart. 

Let's learn creating charts using line chart :

To create a line chart, the steps are as follows :

1. Type the data in our excel worksheet as shown in fig. 2.1 below.

2. Select the range A1:C6

3. On the Insert tab, in the Charts group, choose Line, and select Line with 

Markers.

Fig. 2.1. Inserting a chart type Line chart
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Result :

2.1.3 How to add chart Title

We can easily add a chart title to our Chart in Excel. To add a chart title following 

are the steps below :

1. Select the chart. We will notice that the Chart Tools contextual tab is activated 

as shown in fig. 2.7

2. On the Layout tab, click Chart Title, Above Chart.

Fig. 2.3. Adding Chart Title

3. We will see a caption (Chart Title) above our chart. Enter our desired title. For 

example, Match Analysis.
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Result :

Fig. 2.4. Chart Title

2.1.4 Elements of a Chart

Elements of a Chart are explained as below :

1. Chart area : A chart area contains everything inside the chart window, 

including all parts of the chart.

2. Data marker (or Data point) : A data marker is a symbol on the chart that 

represents a single value in the worksheet. A data marker can be a bar in a bar 

chart, a pie in a pie chart, or a line on a line chart. Data markers with the same 

shape or pattern represent a single data series in the chart.

3. Data series : It is a group of related values such as all the values in a single 

row in the chart. A chart can have just one data series.

4. Axis : It is a line that is used as a major reference for plotting data in a chart. In 

two-dimensional charts there are two axes  the x-axis (horizontal/category) 

and the y-axis (vertical/value).

5. Tick mark : It is a small line intersecting an axis. A tick mark indicates a 

category, scale, or chart data series. A tick mark can have a label attached to it.

6. Plot area : It is the area where our data is plotted and it includes the axes and 

all markers that represent data points.

7. Gridlines : These are the optional lines extending from the tick marks across 

the plot area. It make easier to view the data values represented by the tick 

marks.
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8. Chart text : It is a label or title that we add to our chart. Attached text is a title 

or label that is linked to an axis such as the Chart Title.

9. Legend : It is a key that identifies patterns, colors, or symbols associated with 

the markers of a chart data series. The legend shows the data series name 

corresponding to each data marker 

Just like with normal spreadsheet data, we can sort the data in a PivotTable 

using the Sort & Filter command on the Home tab. We can also apply any type of 

formatting we want. 

2.2 Data Tools

In Microsoft Excel Data Tools are simply tools which make it easy to manipulate 

data. Some of them are used to save our time by extracting or joining data and others 

perform complex calculations on data. 

2.2.1 How to convert Text to Columns:

Sometimes we need to separate the contents of one Excel cell into separate 

columns. For this we can use the 'Convert Text to Columns Wizard'. For example, 

when we want to separate a list of full names into last and first names.

Steps are as follows :

1. Type the data in our worksheet as shown in the fig. 2.5 below :

2. Select the range with full names.

Fig. 2.5. Convert Text to Column
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3. On the Data tab, click Text to Columns.

Fig. 2.6. Text to Column

 The following dialog box appears.

Fig. 2.7. Text to Column Wizard-1

4.  Choose Delimited and click Next.

5. Clear all the check boxes under Delimiters except for the Comma and Space 

check box.

Fig. 2.8. Text to Column Wizard-2

6. Click Finish.
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Result :

Fig. 2.9. Text to Column Result

2.2.2 What is Data Validation ?

In MS Excel, data validation is a powerful feature that is used to set up certain 

rules to dictate what can be entered into a cell. For example, we may want to limit 

data entry in a particular cell to whole numbers between 0 and 10. If the user makes 

an invalid entry, we can display a custom message. Let us learn how to use Data 

Validation with the help of the example below :

Data Validation Example : In this example, we restrict a user to enter a whole 

number between 0 and 10.

Fig. 2.10. Data Validation Example

How to Create Data Validation Rule : To create a data validation rule, the steps 

are as follows :

1. Type the data in our excel worksheet as shown in the fig 2.11.

2. Select cell C2.
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3. On the Data tab, click Data Validation.

Fig. 2.11. Creating Data Validation Rule

On the Settings tab do as shown in the figure 2.12.

1. In the Allow list, click Whole number.

2. In the Data list, click between.

3. Enter the Minimum and Maximum values.

Fig. 2.12. Data Validation Settings

Input Message : Input messages appear when the user selects the cell and tell the 

user what to enter.

On the Input Message tabas shown in the figure 2.13 below do the following:

1. Check 'Show input message when cell is selected'.

2. Enter a title.
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3. Enter an input message.

Fig. 2.13. Data Validation Input Message

Error Alert : If users ignore the input message and enter a number that is not 

valid, we can show them an error alert.

On the Error Alert tab as shown in the figure 2.14 below do the following:

1. Check 'Show error alert after invalid data is entered'.

2. Enter a title.

3. Enter an error message.

4. Click OK.

Fig. 2.14. Data Validation Error Alert
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Data Validation Result : To check our Data Validation result follows the steps as 

below :

1. Select cell C2.

2. Try to enter a number higher than 10.

Fig. 2.15. Data Validation Result

Result :

Fig. 2.16. Data Validation Wrong Input Error 

*�To remove data validation from a cell, select the cell, on the Data tab, click 

Data Validation, and then click Clear All. 

2.3 Protection
In simple words Protection means to keep our stuff safe from misuse from an 

authorised person. In Excel we can protect our workbook/worksheet. 

2.3.1 How to Protect Worksheet 

While working in an organization, we need to keep our work safe from being 
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misused. Our data can be misused or tempered by anyone. So, when we share a file 

with other users, we may want to protect a worksheet to help prevent it from being 

changed. Let's lean how to do this :

Steps to Protect Worksheet :

1. Right click a worksheet tab

or

 Go to Review Tab

Fig. 2.17. Protect Sheet-Tab

2. Click Protect Sheet.

Fig. 2.18. Protect Sheet

3. Enter a password.

4. Check the actions we allow the users of our worksheet to perform.

5. Click OK.
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Fig. 2.19. Protect Sheet Dialog Box

* If we don't check any action, users can only view the Excel file.

6. Confirm the password and click OK.

Fig. 2.20. Confirming Password

Our worksheet is protected now. To unprotect a worksheet, right click on the 

worksheet tab and click Unprotect Sheet. 
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2.4.2 How to Protect Workbook?

A workbook can be protected easily as we have protected a worksheet. A 

workbook can be protected such as :

å� Workbook Structure

å� Workbook Windows

If we protect the workbook structure, users cannot insert, delete, rename, move, 

copy, hide or unhide worksheets anymore.

1. Open a workbook.

2. On the Review tab, click Protect Workbook.

Fig. 2.21. Protect Workbook Tab

3. Check Structure, enter a password and click OK.

Fig. 2.22. Protect Structure Dialog Box

4. Re-enter the password and click on OK.

Fig. 2.23. Confirm Password-Protect Workbook 
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Users cannot insert, delete, rename, move, copy, hide or unhide worksheets 

anymore.

Fig. 2.24. Workbook Protected

Windows : If we protect the workbook windows, we cannot move, change the 

size and close windows anymore.

1. Open a workbook.

2. On the Review tab, click Protect Workbook.

Fig. 2.25. Protect Workbook Tab

3. Check Windows enter a password and click OK.

Fig. 2.26. Protect Windows Dialog Box
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4. Re-enter the password and click on OK.

Fig 2.27 Confirm Password-Protect Workbook 

We cannot move, change the size and close windows anymore.

* To unprotect the workbook, click Protect Workbook and enter the password. 

The structure and window of this workbook are protected.

2.4. View Tab

Fig. 2.28. View Tab

2.4.1 Split

In simple words Split means to break a large object into small parts so that the job 

is easy to do. In Excel we can split our worksheet that contains a large volume of 

data, so that we could compare it if necessary.

How to Split Worksheet : In Excel we can split the worksheet window into 

separate panes and scroll the worksheet in each pane so that we can easily compare 

data from two separate worksheet locations. We can make the panes in a workbook 

window disappear by double-clicking anywhere on the split bar that divides the 

window.
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1. Click the split box above the vertical scroll bar as shown in fig. 2.53

Fig. 2.29. Split box above the vertical scroll bar

2. Drag it down to split our window.

Fig. 2.30. Window split in two panes
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3. Notice the two vertical scroll bars. For example, use the lower vertical scroll 

bar to move to row 12. As we can see, the first 12 rows remain visible.

Fig. 2.31. Window split adjustment

4. To remove the split, double click the horizontal split bar that divides the panes 

(or drag it up).

* In a similar way, we can use the split box to split our window into four panes.

2.4.2 Freeze

Freeze means to make a thing stable or stop the movement. In Excel Freeze means 

to stop the movement of a particular row or column while scrolling a spreadsheet.

How to Freeze Panes of a Worksheet ?

Freeze option is very useful in some cases when we have a long table and want to 

see all. We need to scroll it while looking all the data. We will see that the table 

headings  are also scrolled during scrolling. so it becomes difficult to understand the 

meaning of data without having its heading name hidden. So we can use Freeze 

option if we have a large table of data in Excel. We can freeze either rows or 
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columns. This way we can keep rows or columns visible while scrolling through the 

rest of the worksheet. In this part we will learn how to freeze top row of your 

worksheet :

Freeze Top Row : To freeze the top row, execute the following steps.

1. On the View tab, click Freeze Panes, Freeze Top Row as shown in fig. 2.32

Fig. 2.32. Before Freeze Top Row

2. Scroll down to the rest of the worksheet.

Fig. 2.33. After Freeze Top Row

Result : Excel automatically adds a black horizontal line to indicate that the top 

row is frozen.
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How to Unfreeze Panes of your worksheet : To unlock all rows and columns, 

execute the following steps.

1. On the View tab, click Freeze Panes, Unfreeze Panes as shown in fig. 2.34

Fig. 2.34. Unfreeze Panes

We can freeze both row and column simultaneously using freeze panes option. 

We can easily read the data of rows column white scrolling.

How to Freeze Panes of a Worksheet : To freeze panes, execute the following 

steps. 

1. Select row 3 as shown in fig. 2.35.

2. On the View tab, click Freeze Panes, Freeze Panes as shown in fig. 2.35

Fig. 2.35. Freeze Panes Tab

3. Scroll down to the rest of the worksheet.

Result : All rows above row 3 are frozen.

* To keep columns visible while scrolling to the right of the worksheet, select a 

column and click Freeze panes.
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2.4.3 How to Hide/Unhide Columns, Rows and Sheets

If we want to save our data not being misused from an un-authorised person then 

Excel has an excellent feature to hide the selected rows, columns, and sheets. This 

could be very handy especially when we want to protect specific content from any 

sort of misuse. Open our Excel workbook in which we want to hide rows, columns or 

sheets. 

Hiding Rows : In desired spreadsheet select the rows (for multiple selection hold 

Ctrl key and keep selecting) we want to hide and navigate to Home tab.

 

Fig. 2.36. Hide Rows

From Cells group, click Format button. Now from Hide & Unhide options, click 

Hide Rows.

Fig. 2.37. Hide Row option
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Upon click it will automatically hide the selected rows. The rows 4 to 12 numbers 

are now hidden.

Hiding Columns : For hiding the columns in specific sheet, following are the steps :

1. Select the columns we want to hide as shown in fig. 2.38 column E to Column 

J have been selected.

 Fig. 2.38. Hide Columns

2. Now click on Format button in Cells group. Now Click on Ù Hide & Unhide 

options then click Hide Columns.

 Fig. 2.39. Columns Hidden
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3. We will notice that column from E to Column J have been hidden as shown in 

fig. 2.38. You will notice that the selected column are hidden in fig. 2.39.

How to Hide Worksheets : Likewise Rows/Columns We can also hide a 

worksheet. Following are the steps to do so :

1. Select the sheet which we want to hide as shown in fig. 2.40.

 Fig. 2.40. Worksheet Hide

2. Now Click Hide Sheet from Hide & Unhide options from Cell group in 

Home Tab as show in fig. 2.41.
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Fig. 3.41. Hide and Unhide

3. Click on Hinde Sheet Option from Hide and Unhide as shon in fig. 2.41. We 
will notice that upon click the whole sheet will be hidden.

How to Unhide Rows, Columns, and Sheets : For getting back the hidden sheets, 
rows and columns, click Format, and click on Unhide Rows/Unhide Column/ 
Unhide Sheet from Hide & Unhide options.

Fig 2.42. Unhide/Rows/Columns/Sheet
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Things to Remember

1. A chart is a tool in MS Excel that is used to communicate our data graphically.

2. Data validation is a powerful feature that is used to set up certain rules to 

dictate what can be entered into a cell.

3. In Excel we can split the worksheet window into separate panes.

4. Excel automatically adds a black horizontal line to indicate that the top row is 

frozen.

5. Excel has an excellent feature to hide the selected rows, columns, and sheets.

Exercise
1. Fill in the Blanks : 

 1. .......................... contains everything inside the chart window.

 (a) Data markers (b) Axis (c) Chart area (d) None of these

2.  feature allows us to set up certain rules...........................

 (a) Data validation  (b) Pivot Table 

 (c) Char   (d) None of these

3. We  can the worksheet window into separate panes........................... 

 (a) Hide (b) Split (c) Arrange (d) None of these

4. By using  we can keep rows or columns visible while scrolling...........................

 (a) Hide (b) Split (c) Freeze Panes (d) None of these

5 By .......................... .  Data can be show graphically. 

 (a) Formula  (b) Function  (c) Filter  (d) Chart

2. Short Answer Type Questions : 

1. What is a data tools in MS Excel ?

2. Write down Any five elements of chart in MS Excel.

3. What do you mean by protection in MS Excel. ?

4. What do you mean by split in MS Excel ?

5. What do you mean by Freezing of worksheet ?

3. Long Answer Type Questions :

1. What is a Chart ? Write down the different types of charts in MS Excel.

2. What is Data Validation ? Explain with example? 

3. What is Protection ? Write down the steps to protect a Worksheet.

4. Write steps to hide coloumn in Worksheet. 
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Objective of this Lesson
3.1 Networking

3.2 Need of Networking

3.3 Components of Computer Networks

3.4 Advantages and Disadvantages of Network

3.5 Network Topologies

3.6 Data Communication

3.7 Types of Networks
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Introduction
The dynamic world today needs fast communication channels to move date 

frequently form one place to another, so data transmission over distances has become 

essential. To move the data quickly from one place to another, the concept of 

networking has been introduced. In networking the computers from different parts 

of the world are connected to each other to share data with each other.

3.1 Networking
A network is the group of two or more computers that are linked in order to 

share resources (such as printers and CDs), exchange files, or allow communications. 

VPN over Satellite

Internet

VPN-Router

VPN-Firewall

Headquarter Client with Sat-Connection

Fig. 3.1. Networking



The computers on a network may be linked through cables, telephone lines, radio 
waves, satellites, or infrared light beams. Network is capable of sharing Software and 
Hardware resources between many users

Network connections between computers are typically created using cables 
(wires). However, connections can be created using radio signals (wireless/Wi-Fi), 
telephone lines (and modems) or even, for very long distances, via satellite links.

Note : A computer that is not connected to a network is known as a standalone 
computer. 

3.2 Need for Networking
The ability to exchange data and communicate efficiently is the main purpose of 

networking computers. Some of common factors for Networking are :

Fig. 3.2. Need for networking

Networks are used to :

1. Facilitate communication via email, video conferencing, instant messaging, etc.

2. Enable multiple users to share a single hardware device like a printer or 
scanner.

3. Enable file sharing across the network.

4. Allow for the sharing of software or operating programs on remote systems.

5. Make information easier to access and maintain among network users.

6. Allow Multi users to play game together from different locations.

7. Allow Multi users to access the Internet simultaneously without having to pay.

8. Store data centrally (using a file server) for ease of access and back-up.
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3.3 Components of Computer Networks
Computer networks allow users to connect over distances. They also enable file 

sharing, hardware sharing and instant communication, making them a convenient 

tool for the home and a necessity for offices and organizations like universities. A 

computer network consists of several components, each of which is important to 

making the network function properly.

Computer network components include the major parts that are needed to install 

a network both at the office and home level. Before delving into the installation 

process, you should be familiar with each part so that you could choose and buy the 

right component that fits with your network system.

3.3.1 Computer

The purpose of a network is to join computers together. For this to work the first 

step in setting up a network is to identify computers and users who may wish to 

participate in the network. The computers will also need to include software that 

enables them to connect to the network. 

There are two types of computers which are used for networking :

3.3.1.1  Client or Node

Client/Node is the normal computer system which is connected to network for 

sharing of resources.

3.3.1.2 Server

It is a powerful computer. It helps in sharing of resources or information. It 

controls all other nodes.

Fig 3.3. Client/Server
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3.3.2 Network Interface Card

A network interface card (NIC) is a computer circuit board or card that is installed in 

a computer so that it can be connected to a network.. It should be fitted in each client 

and server computer. Actually it develops relationship between card, server and 

client. Every client linked to network interface card has its own specific number is 

called node address. There are two types of network cards : wired and wireless. The 

wired NIC uses cables and connectors as a medium to transfer data, whereas in the 

wireless card, the connection is made using antenna that employs radio wave 

technology.

3.4. Network Interface Card

3.3.3 HUB/Switch

A networking hub/Switch is a device that allows you to connect multiple 

computers to a single network device. In its simplest form a hub works by 

duplicating the data packets received via one port and making it available to all 

ports, therefore allowing data sharing between all devices connected to hub

                Fig. 3.5. Hub                  Fig. 3.6. Switch

Ethernet cable

Ethernet Port

Server PC PC PC PC

Printer Network Switch ADSL Modem
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3.3.4 Router

A router is hardware device designed to receive, analyze and forward incoming 

data within a network or to another network.

Fig. 3.7. Router

3.4 Advantages and Disadvantages of  Network

3.4.1 Advantages of Network

1. Sharing files, data and information : You can share data program and 

different resources with it. It is only possible because all the files are stored on 

server (Central computers, Server allows sharing of these files)

2. Sharing Hardware and software : you can share hardware and software 

within network easily. For  example, a printer can be shared among the users 

in a network so that there's no need to have individual printers for each and 

every computer in the company. 

3. Communication Media : Network provides a very fast communication media 

e.g. E-mail is used as a fast media in different offices.

4. File Integrity : File integrity remains continuous due to network. It saves 

much time. Network helps in fast saving and sharing of files.

5. Cost effective : We can share costly input and output devices like printer with 

network . It reduces the cost of system.

6. Reliability : Network ensures use of many resource to us e.g. when hardware 

fails, information can be recovered from other computer with the help of 

network.

7. Flexibility : It provides more flexibility because in it there is a possibility of 

connecting devices of different businessmen.

8. Backup : It is difficult to get back up of a file from different computers. But it 

is easy to take backup from server if we are linked with network.

9. Security : Network provides security to us. Network user can run a few files 

or applications.
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10. Speed : Sharing and transferring files within networks is very rapid, 

depending on the type of network. This will save time while maintaining the 

integrity of files.

3.4.2 Disadvantages of  Network

1. Network Failure : All the central facilities may fail due to network failure.

2. Management : Management of whole network is tough.

3. Security : Danger of security is always present on network. Data can be 

misused on network.

4. Expensive to Build : Building a network is a serious business in many 

occasions, especially for  

5.   Large scale organizations : Cables and other hardware are very pricey to buy 

and replace. 

3.5 Networks Topologies
The term Network Topology defines the geographic arrangement of computer 

networking devices. The term Topology refers to the way in which the various 

nodes or computers of a network are linked together. It describes the actual layout of 

the computer network hardware. Two or more devices connect to a link; two or 

more links form a topology. Topology determines the data paths that may be used 

between any pair of devices of the network.

It may be depicted physically or logically. Physical topology is the placement of 

the various components of a network, including device location and cable 

installation, while logical topology illustrates how data flows within a network, 

The selection of a Network Topology for a network cannot be done in isolation as 

it affects the choice of media and the access method used 

                

Fig. 3.8. Link vs Topology

Node A Node B

Link

(a) Link between two bevices (b) Link between two bevices

HUB
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The following factors are considered while selecting a topology:  

1. Cost 

2. Reliability 

3. Scalability 

4. Bandwidth capacity 

5. Ease of installation 

6. Ease of troubleshooting 

7. Delay involved in routing information from one node to another. 

3.5.1 Topologies

While making a selection of a particular topology we consider the relative status 

of different devices that are to be linked. 

The nodes in a network can have following two relationships : 

1. Peer to Peer : In this relationship, all the devices in the network have equal 

status in sharing the link. For example, Ring & Mesh topology. 

2. Client-Server (Primary-Secondary) : In this, one device controls the traffic 

(called Server) and all other devices (Called Clients) transmit through primary 

device. e.g. Star topology. 

3.5.2 Types of Network Topology

 

3.9. Networks Topologies 

3.5.2.1 Bus Topology

Bus Topology is the simplest of network topologies. In this type of topology, all 

the nodes (computers as well as servers) are connected to the single cable (called 

bus), by the help of T- connectors. This central cable is the backbone of the network 

and is known as Bus (thus the name). Every workstation communicates with the 

other device through this Bus. 

A signal from the source is broadcasted and it travels to all workstations 

connected to bus cable. Although the message is broadcasted but only the intended 

Topology

Bus Ring Star Mesh Tree Hybrid 
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recipient, whose MAC address or IP address matches, accepts it. If the MAC /IP 

address of machine doesn't match with the intended address, machine discards the 

signal. 

Fig. 3.10. Bus Topology

Advantages of Bus Topology : 

å� Any new computer can be attached easily.

å� It is a cheaper topology.

å� If one computer fails, others are not affected.

å� Cable required is least compared to other network topology. 

å� Used in small networks. 

å� It is easy to understand & connect

Disadvantages of Bus Topology :

å� More wire is needed to connect more nodes.

å� If the main central line fails the entire network collapses.

å� The efficiency of network is reduced with the increase in number of 

computers.

å� Cable has a limited length. 

å� It is slower than the ring topology.

å� Terminators are required at both ends of the backbone cable 

å� Difficult to identify the problem if the entire network shuts down

3.5.2.2 Ring Topology

In it all the computers are logically linked in the form of a ring. In it each node is 

connected to two other nodes. Rings can be unidirectional, with all traffic travelling 

Terminator

T-Connector
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either clockwise or anticlockwise around the ring.  At the time of accepting data, 

each node checks its address. If data is for that node only then it is received, 

otherwise not. 

There are two kinds of ring topologies :  

1. Single Ring 

2. Dual Ring 

1. Single ring : In single ring network, a single cable is shared by all the devices 

and data travel only in one direction. 

 Each device waits for its turn and then transmits. When the data reaches its 

destination, another device can transmit. 

2. Dual ring : This topology uses two rings to send the data, each in different 

direction. Thus allowing more packets to be sent over the network. 

                            

Fig. 3.11. Ring Topology

Advantages of Ring Topology :

å Very orderly network where every device has access to the token and the 

opportunity to transmit 

å Performs better than a bus topology under heavy network load 

å Does not require a central node to manage the connectivity between the 

computers

å It is easier to locate the problems with device and cable i.e. fault isolation is 

simplified. If one device does not receive a signal within a specified time, it 

can issue an alarm.
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Disadvantage of Ring Topology :

å� Failure of one computer can affect the total network

å� Difficult to troubleshoot

å� Adding or removing Computers disrupts the network 

å� A ring network requires more cable than a bus network.

3.5.2.3 Star Topology

In this type of topology all the computers are connected to a central device called 

“hub” which may be a hub, a router or a switch. . This hub/switch is the central node 

and all others nodes are connected to the central node. The computers present in star 

topology cannot have a direct relation with each other. They have to be linked via 

hub. In it minimum distance between node and hub is 100 meter. 

Fig. 3.12. Star Topology 

Advantages of Star Topology :

å� It is easily to prepare and connect.

å� Failure of one computer does not effect the other.

å� More nodes can be connected in it. With it propagation delay does not   

increase.

å� It is  easier to find faults in network. 

å� Easy to troubleshoot. 

å� Easy to setup and modify.
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Disadvantages of Star Topology :

å� Failure of hub results in failure of complete network.

å� Cost of installation is high

å� Performance and as well number of nodes which can be added in such 

topology is depended on capacity of central device.

3.5.2.4 Mesh Topology

In mesh topology, each node is connected to every other node in the network 

each computer and network device is interconnected with one another

Fig. 3.13. Mesh Topology

A mesh topology can be a full mesh topology or a partially connected mesh 

topology.

In a full mesh topology, every computer in the network has a connection to each of 

the other computers in that network. 

In a partially connected mesh topology, at least two of the computers in the network 

have connections to multiple other computers in that network. 

Computer Computer

Computer Computer

Computer
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Advantages of Mesh Topology :

å� Data can be transmitted from different devices simultaneously. This topology 

can withstand high traffic.

å� Even if one of the components fails there is always an alternative present. So 

data transfer doesn't get affected.

å� In the event that one of those nodes fails, network traffic can be directed to 

any of the other nodes.

å� Expansion and modification in topology can be done without disrupting other 

nodes.

Disadvantages of Mesh Topology :

1. Installation and configuration is difficult.

2. Cabling cost is more.

3.5.2.5 Tree Topology

A tree network is a combination of two or more star networks connected together  

which involve a variety of single nodes connected to a central node. Multiple stars 

involve either a series or tertiary nodes attached to two or more secondary nodes, 

which are attached to the tree's primary trunk node. Experts may define a tree 

topology as a combination of star and bus topologies, where multiple elements are 

connected through a single lateral connection.

Fig. 3.14. Tree Topology

Advantages of Tree Topology :

1. It is an extension of Star and bus Topologies, so in networks where these 

topologies can't be implemented individually for reasons related to scalability, 

tree topology is the best alternative.
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2. Expansion of Network is possible and easy.

3. Here, we divide the whole network into segments (star networks), which can 

be easily managed and maintained. 

4. Error detection and correction is easy.

6. If one segment is damaged, other segments are not affected

Disadvantages of Tree Topology :

å� Because of its basic structure, tree topology, relies heavily on the main bus 

cable, if it breaks whole network is crippled.

å�  As more and more nodes and segments are added, the maintenance becomes 

difficult.

å�  Scalability of the network depends on the type of cable used.

å� It has higher cabling cost in setting up a tree structure.

3.5.2.6 Hybrid Topology

 A hybrid topology is a type of network topology that uses two or more other 

network topologies, including bus topology, mesh topology, ring topology, star 

topology, and tree topology.

It is two different types of topologies which is a mixture of two or more topologies.

Fig. 3.15. Hybrid Topology

 Advantages of Hybrid Topology :

1. Reliable as Error detecting and troubleshooting is easy.

2. Effective.

3. Scalable as size can be increased easily.
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Disadvantages of Hybrid Topology :

1. Complex in design.

2. Costly.

3.6 Data Communication?
Data communication is exchange of data between two or more computers (a 

sender/source and a receiver) with the help of communication medium. The device 
that transmits the data is known as sender/source and the device that receives the 
transmitted data is known as receiver.

Data communication must fulfil/obey following three conditions : 

Delivery : Network should deliver the data at proper place.

Accuracy : Data communication should be free from fault.

Time limit : Data should reach destination without any delay

3.6.1 Components of Data Communication

Sender : Sender prepares information (data) and sends it

Medium  : It carriers the information from sender to receiver 

Receivers : Receiver receives the information.

Protocol : There are rules under which data transmission takes place between 

sender and receiver.

Fig. 3.16. Data Communication

3.6.2 Methods of data transmission

Fig. 3.17. Transmission Mode

Step 1 :
Step 2 :
Step 3 :
............
............

Step 1 :
Step 2 :
Step 3 :
............
............
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Protocol Protocol
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Methods of data transmissions means direction of flow of data between sender 
and receiver. Three methods of data transmission are given below :

1. Simplex : In it communication is one direction. So information can flow only 
in one direction its reverse is not possible. The message source works as the 
transmitter. It sends the message over the data channel to the receiver. The 
receiver is the destination of the message. Example : television communication. 

Fig. 3.18. Simplex Mode

2. Half duplex : In it information can flow in both directions but not at the same 

time. In other words if information is sent by one system then second can only 

receive it or vice versa as shown in figure 3.19. Example : walky-talky system 

used by police and force. 

Fig. 3.19. Half-duplex Mode

3. Full duplex : In it information can move in both directions at same time. It 

provides fast communication as shown diagram 3.20. Example : telephone 

system :

Fig. 3.20. Full-Duplex Mode

3.6.3 Communication Channel

Communicating data from one location to another requires some form of 

pathway or medium. These pathways, called communication channels, use two types 

of media: cable (twisted-pair wire, cable, and fiber-optic cable) and broadcast 

(microwave, satellite, radio, and infrared).
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3.7 Types of Networks
There are several different types of computer networks. Computer networks can 

be characterized by their size as well as their purpose. 

The size of a network can be expressed by the geographic area they occupy and 

the number of computers that are part of the network. Networks can cover anything 

from a handful of devices within a single room to millions of devices spread across 

the entire globe. 

Network may be small or large based on it size, complexity and Distribution area. 

On the basis of its area of distribution, network is divided into three parts : 

1.  PAN(Personal Area Network)

2.    LAN (Local Area Network)

3. MAN (Metropolitan Area Network)

4.  WAN (Wide Area network)

3.7.1 Personal Area Network

A personal area network, or PAN, is a computer network organized around an 

individual person within a single building. This could be inside a small office or 

residence. Personal area networks can be constructed with cables or be wireless. It  

refers to the interconnection of information technology devices or gadgets (include 

laptop computers, PDAs, cellphones, printers) within the environment of an 

individual user (typically within 10 meters).

 

Fig. 3.21. PAN

3.7.2 Local Area Network (LAN)

A LAN is a network that is used for communicating among computer devices, 

usually within an office building or home. LAN's enable the sharing of resources 
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such as files or hardware devices that may be needed by multiple users.  it Is limited 

in size, typically spanning a few hundred meters, and no more than a mile. it is fast, 

with speeds from 10 Mbps to 10 Gbps. it Requires little wiring, typically a single 

cable connecting to each device. It has lower cost compared to MAN's or WAN's. 

LAN's can be either wired or wireless. Twisted pair, coax or fiber optic cable can be 

used in wired LAN's. It is suitable to bus, ring or star topology. In it generally coaxial 

Cable, twisted pair and optical fiber etc.  transmission media is used.

Fig. 3.22. LAN

3.7.3 Metropolitan Area Network (MAN) : 

It is distributed to a city , college campus or large area just like Cable TV network 

it is also single. In it many LANs are connected. A MAN is optimized for a larger 

geographical area than a LAN, ranging from several blocks of buildings to entire 

cities. .A MAN might be owned and operated by a single organization, but it usually 

Fig. 3.23. MAN

77



will be used by many individuals and organizations. A MAN often acts as a high 

speed network to allow sharing of regional resources. A MAN typically covers an 

area of between 5 and 50 km diameter. Examples of MAN: Telephone company 

network that provides a high speed DSL to customers and cable TV network

3.7.4. Wide Area Network  (WAN)

WAN covers a large geographic area such as country, continent or even whole of 

the world. WAN can contain multiple smaller networks, such as LANs or MANs. In 

this network telephone lines, satellite, microwave etc. media are used. These 

transmission media are linked with Router. Router is a device which determines the 

route of information from sender to receiver. The world's most popular WAN is the 

Internet. 

Fig. 3.24. WAN

Things to Remember
1. A network is the group of two or more computers.

2. Client/nodes is the normal computer system which is connected to network 

for sharing of resources.

3. Hub is a device that allows you to connect multiple computers to a single 

network device.

4. The term network topology defines the geographic arrangement of computer 

networking devices.

Network
servers

Network
UsersLAN
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Router

LANLAN

LAN LAN
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5. Mainly topology is of six types.

6. Sender, Medium, Receiver and protocol are parts of data communication.

7. Computer Networking has four parts PAN,  LAN, MAN,  WAN..

Exercise
1. Fill in the Blanks : 

 1. .......................... is s the group of two or more computers.

  (a) Network (b) Internet (c) Wireless (d) Topology

 2. .......................... is the normal computer system which is connected to network 

for sharing of resources.

  (a) Server (b) Client/Node (c) LAN (d) WAN

 3. .......................... is  a device that allow you to connect multiple computers to a 

single network device

  (a) HUB (b) BUS (c) Ring (d) Star

 4. In .......................... network, a single cable is shared by all the devices and data  

travel only in one direction

  (a) Single Ring (b) Dual ring (c) MAN (d) LAN

 5. .......................... prepares information and sends it

  (a) Protocol (b) Receiver (c) Sender (d) Hub

2. True/False :

 1. LAN covers a large geographic area.

 2. In full duplex, information can move in both directions

 3. Protocol are rules under which data transmission takes palace

 4. Network does not provide security to us.

 5. The efficiency of network is increased with increase of computers.

3. Short Answer Type Questions :

 1. Name any four Network Topology.

 2. What is Star Topology?

 3. Write a short note on Router.
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 4. Write a note on Hub.

 5. What are the two types of ring topologies ?

4. Long Answer Type Questions : 

 1. What is Network ? Explain its advantages and disadvantages.

 2. Write information about the parts of computer network.

 3. Write about the types of networks.

 4. What are the methods of data transmission ?
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4.1 Terminology used in Databases

In databases many technical terms are used. Some of the important terms are as 

follows :

å Attribute or Data item : In general, an attribute is a characteristic. In a 

database management system (DBMS), an attribute refers to a database 

component, such a table. It also may refer to a database field. Attributes 

describe the instances in the row of a database.

  

Fig 4.1

å� Record : In databases, a record is a group of related data held within the same 

structure. Specifically, a record is a group of fields within a table that reference 

one particular object. The term record is frequently used synonymously with 

row. A record is also known as a tuple.

 For example : a Student  record may include items, such as first name, roll no, 
address, email address, date of birth and gender. 

å File : A file is a container in a computer system for storing information. Files  
in computers fields are very similar in features to that of paper documents 
used in library and office files. There are many kind of  files such as text files, 
data files, directory files, binary and graphic files, and these different types of 
files store different types of information. Here we are giving our view on a  
database  file. It is a combination of records which are interrelate with each 

thother. For example Student File of 9  class. In this file we can store students 
recast as serial number, student name, father's name, date of birth etc.

4.2 Data and Information 
Data and information are the words which we used in our routine life. Both the 

words are used to increase our knowledge. Both words looks same but lot of 
difference in these words in real manner.
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Data are small raw materials such as character, numbers, pictures etc.|after 
processing on these raw materials we get a meaningful information|useful 
Information provides the answer to some of our questions of us like why, How, where ?

Fig. 4.2. Data & Information

Suppose we collect any of our school data like your name, roll no, class, number 
address, phone number etc. This is only data but when we do processing on this 
according to our need it will become information. Let's get understand it with an 
example which is as follows :

Fig. 4.3. Collected Data

 

Fig. 4.4. Information Based on Data

4.3 What is Database
Database is a place where not only your data get store as well as relationship 

between data and information also been stored. The primary basis of the database is 

Information associates with the problem is used by many users or even by a single 
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user. Users don't need to worry about the various type of data how it could be store 

on their computer.

Database is prepared from Information related to each other. It is expressed in 

tabular form. Database is a proper arrangement of information. There is no use of 

unarranged information. Database is a collection of a large amount of data. 

Dictionary is the best example of data in which all words are arranged in an 

alphabetical sequence which makes it easier for any word to search.

Computer database is collection of well-arranged records that is stored in the 

computer. User can obtain the required information from the database. The decision 

can be taken on the basis of this information. Software called database management 

system is used to prepare database.

4.3.1 Some Necessary instructions for designing a good database

These days all the commercial areas nearly depends upon the database. Means all 

the business activities done by the computer which are very accurate and up to date.

So it becomes necessary when designing a database that takes care of certain 

things that are as follows :

1. The  data which is going to store in database must be accurate ,well arranged 

and complete so it could be easily fetch when required by someone.

2. While creating database system we have to keep in mind that whether 

database application is going to use on any website or any other local area 

network  or on both the result must be able to get very fast and accurate. 

3. The database design is the main aspect of the database we can't ignore it if the 

database design is not  planned well a good program cannot get rid of  facing  

problems to run on it.

4. Database should be design while  thinking  about  the future problem.

4.4 Uses OF Database System Application

Database application systems have been used at so many places around us  some 

of the main are as follows :

1. In banking sector to look after of the account of the customer.

2. For airline reservation and making schedule of the information. 

3. In universities to fetch information of the students and about the courses.
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4. To create the monthly statement of an organization .

5. For telecommunication 

6. In finance to store the information of sales and purchase.

7. In sales to store the information of customers purchased products.

8. In Manufacturing management to store the information of  warehouses orders 

and supply of the product.

9. In human resource to store  the employee's salary bills, payrolls, taxes etc.

4.5. File Processing System

In old approach, before to computer, all information's were stored on papers. 

When we need information, we used to search through the papers. If  we remember 

that particular date or category of information that we are searching for, we go to 

that particular session in the papers. If the data is limited, then all these tasks are 

very easy to do. Imagine if we have to use this kind of paper work for  library 

information or information about a students in School, or baking system! How do we 

search for single required record on papers? It is a never ending task. But, Computers 

solved our problems.

When computers came, all these jobs become very easy to do so. But initial days, 

these records were stored in the form of files. That's why this system is Called FILE 

PROCCESING SYSTEM. This is  the way we stored data or record  in files is similar 

to papers, in the form of flat files  to be simpler, in notepad. The information's stores 

all in the notepads with each fields of information separated by space, tab comma, 

semicolon or any other symbol. 

All files were grouped according to their categories; files uses only related 

information's and each file is named properly. For example a  Student information. 

Student files for each class were bundled inside different folders to identify it 

quickly. Now, if we want to see a specific Student detail from a file, what do we do ? 

We must have to  know which file will have the data, we open that file and search for 

his details. Fine, here we see the files; we can open it and search for it. But imagine if 

we want to display student details what we will do. It is really a difficult work to do.. 

Now how will we open a file, read or update it ? These kind of problems  were arise 

in file processing system. Now we are going to discuss the drawbacks of file 

processing system as follows :
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4.5.1 Drawback of file processing system

1. Data Mapping and Access : Although all the related information's are 

grouped and stored in different files, there is no mapping between any two 

files.

2. Data Redundancy : There were no methods to validate the insertion of 

duplicate data in file system. Any user can enter any data. File system does 

not validate for the kind of data being entered. Duplicate data in the system is 

not appreciated as it is a waste of space, and always lead to confusion and 

mishandling of data. SO the purpose of storing the data is lost. 

3. Data Dependence : In the files, data are stored in specific format, say tab, 

comma or semicolon. If the format of any of the file is changed, then the 

program for processing this file needs to be changed. But so many program 

also using this file so whole data get upset. That is smallest change in the file 

affect all the programs and need changes in all them.

4. Data inconsistency : This mismatch in different copies of same data is called 

data inconsistency. This has occurred here, because there is no proper listing 

of files which has same copies of data.

5. Security : Each file can be password protected. But what if we have to give 

access to only few records in the file? For example, user has to be given access 

to view only their result  information in the file. This is very difficult in the file 

system.

6. Integrity : If we need to check for  insertion criteria while entering the data 

into file it is not possible directly. We can do it by writing programs. There is 

no direct checking facility in the file system. Hence these kinds of integrity 

checks are not easy in file system.

7. Concurrent Access : Accessing the same data from the same file is called 

concurrent access. In the file processing  system, concurrent access leads to 

incorrect data.

4.6 DBMS
The full name of DBMS is data management system. To overcome all drawbacks 

of file processing system, a new system called database management system was 

developed. A database management system (DBMS) is software for creating and 

managing databases. The DBMS provides users and programmers a systematic way 

to create, retrieve, update and manage data. A DBMS makes it possible for end users 
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to create, read, update and delete data in a database. The DBMS essentially serves as 

an interface between the database and end users or application programs ensuring 

that data is consistently organized and remains easily accessible. The main function 

of a DBMS is to provide efficient and reliable methods of data retrieval to many 

users.

Fig. 4.5. DBMS relation with database & users

4.6.1 Advantages and disadvantages of DBMS

Advantages of DBMS :

å� Redundancy is being controlled in DBMS. By having centralized database 

most of the redundancy can be avoided.

å� When the same data is duplicated and changes are made at one site, which is 

not propagated to the other site, it gives rise to inconsistency these kind of 

situations will controls in DBMS.

å� Data  is shared by multiple applications or by multiple users in  DBMS.

å� We don't have to worry about the loss of data because DBMS Providing 

Backup and Recovery.

å� In DBMS there is Restricting unauthorized access to the database.

å� DBMS Solves Enterprise Requirement than Individual Requirement but it can 

also solve some individual requirement 

å� DBMS is a central system, so standard can be enforced easily may be at 

Company level, Department level, National level or International level.

å� In DBMS ,Data Model can be developed

å� DBMS systems provide mechanisms to provide concurrent access of data to 

multiple users.

User 1

User 2

User 3

DBMSDatabase
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Disadvantages of DBMS :

å� It is Complex you must have to get training to use the database

å� However, the DBMS is written to be more general, to cater for many 

applications rather than just one. The effect is that some applications may not 

run as fast as they used to.

å� Higher impact of a failure so there is every possibility of damaging the data

å� The cost of DBMS varies significantly, depending on the environment and 

functionality provided. There is also the recurrent annual maintenance cost.

å� An extra hardware is needed.

å� Conversion cost is very high of the DBMS. its not easy to move it here and 

there.

å� The complexity and breadth of functionality makes the DBMS an extremely 

large piece of software, occupying many megabytes of disk space and 

requiring substantial amounts of memory to run efficiently.

4.7 DBA
DBA stands for database administrator. DBA should be a person or bunch of 

persons. Database administrator (DBA) directs or performs all activities related to 

maintaining a successful database environment. Responsibilities include designing, 

implementing, and maintaining the database system; establishing policies and 

procedures pertaining to the management, security, maintenance, and use of the 

database management system. In  the end we can say that  all the functions of 

database are controlled by DBA.

Different types of DBA's according to their responsibilities are as follows :

1. Administrative DBA

2. Development DBA

3. Architect DBA

4. Data Warehouse DBA 

Main Responsibilities of DBA are the following :

1. DBA has to take care of the Database design and implementation. 

2. DBA will Implement and maintain database security . 

3. DBA is responsible  for the Database  and application tuning and performance 

monitoring too. 

4. DBA is responsible to Setup and maintain documentation and standards. 
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5. DBA will look upon the plan growth and changes.

6. DBA have to establish and maintain sound backup and recovery policies and 

procedures.

7. DBA decides about which kind of hardware will be in use.

8. DBA have right to change data according to the needs of user.

9. DBA fix data validation for the users.

4.8 Redundancy 
A very large amount of duplicate data stores frequently  in database in duplicate 

form again and again and when same duplicate data stores again and again in 

database it produce lot of problem so it is very tough experience to manage the data. 

To frequently  store an identical data again and again in database is called data 

redundancy. 

4.9 Keys in DBMS
Keys are very important part of  database management system. They are used to 

establish and identify relation between tables. They also ensure that each record 

within a table can be uniquely identified by combination of one or more fields within 

a table.

1. Super Key : Super key is defined as a set of attributes within a table that 

uniquely identifies each record within a table. Super Key is a superset of 

Candidate key. 

2. Candidate Key : Candidate keys are defined as the set of fields from which 

primary key can be selected. It is an attribute or set of attribute that can act as 

a primary key for a table to uniquely identify each record in that table. 

3. Primary Key : Primary key is a candidate key that is most appropriate to 

become main key of the table. It is a key that  uniquely identify each record in 

a table.

4. Composite Key : Composite Key is the key which consists of two or more 

attributes that uniquely identify an entity occurrence is called Composite key. 

But any attribute that makes up the Composite key is not a simple key in its 

own.

5. Foreign key : Foreign key is the key in rational database that provide link 

between two tables because it references  the primary key of the another table 

and it established a link between them. Foreign keys are more difficult to 
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implement than primary key. SO we can say primary key of a first table is 

called foreign key of other table.

 

Fig. 4.6. Student Table

Fig. 4.7. Main Table

In student table roll number is primary key. In main table it is foreign key.

4.10 Normalization
Without Normalization, it becomes difficult to handle and update the database, 

without facing data loss if data is not normalized, Insertion, Updating and Deletion 

Differences are very frequent.

Normalization is a scientific way in which difficult table is make quite simple in terms of  

understandable by  user. To reduce Redundancy from tables and to reduce database 

Inconsistency or to remove and to make database strong. we should adopt some 

rules written as follows but  it should also keep in mind that at time of normalization 

not any damage been done to information :

1. There should be an identifier in each table.

2. In each table single type of entity should be stored

3. Null value should store at minimum

4. Same Values that should take place use less frequently in database.

Normalization Concept:- To implement Normalization concept various normal 

forms are used. Tables are always  is in normal form. commonly used Normal forms 

are written as follows :

1. First Normal Form (1NF)

2. Second Normal Form (2NF)

3. Third Normal Form (3NF)
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4. Fourth Normal Form (4NF)

5. Boyce Coded Normal Form

Fig. 4.8. Picture of Normal forms

4.11 Relationships 
Relationship allow relational database to split and store data in different tables.it 

is a situation between two relational databases tables when one table has a foreign 

key which was referred from the other tables primary key 

Types of relationship are as under

One-to-One : One to one is implemented using single table by establishing 

relationship between same type of column in table. Here one entity is associated with 

many other entities.

One-to-many : One to many is implemented while using two tables with primary 

and foreign key relationship . Here one entity is associated with many other entities .

 Many-to-Many : Many to Many implemented using a junction table. The keys 

from both the tables from composite primary key of the junction table. Many entities 

are related with many other entities.

4.12 What is Oracle?
Oracle is world's largest software company. it was founded in 1977 with the name 

of Relational Software Corporation, and This Company developed first Relational 

Database Management Software (RDBMS) Oracle in the world. The main reason to 

make it is that database is to be compatible with the newly founded SQL language 
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and the second reason was to build database software in C language so the database 

soft wares can run with ease.

4.12.1 SQL (Structure Query Language)

Structure query language is a high level language which is used to store, control 

and amend the database. It is based on the concept that how much data is needed by 

a programmer .SQL is based on relational database management system.

Fig 4.9

SQL Advantages  :

1. SQL is not only a high level language even we have to use it for maintain the 

data, update data and controlling the data.

2. SQL provides the facility to a user to do work simultaneously in different 

databases 

3. Program build in SQL is portable means it is very easy to a user to move it 

anywhere  

4. SQL is an easy and simple language to learn and it use to make tough 

programs.

4.13 Data Models
Data model means it is a way to give us information  about the structure of 

database. Means it  is used to describe data, relationship to data, consistency of data 

etc. It has been divided into mainly three parts that are as follows :

1. Object Oriented logically model : It is used to describe  data line by line. It is 

of five type :

 1. Binary model

 2. Functional Model

 3. Entity relationship model

 4. Object oriented model

 5. Semantic data model
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2. Record Base Logical Model : It is also used to describe data line by line but a 

format is used in it permanently. Each record has its own attributes and fields 

that are used under fixed access. It is of three types :

 1. Network model

 2. Relational Model 

 3. Heirarchical Model 

3. Physical Data Model : It has been used to describe data  at lowest level of the 

database. Some parts of  it as follows

 1. Entity : Tells about different kind of entities of the database.

 2. Attributes : It tells about the entity of users Name, Address etc.

 3. Entity set : It is  the mixture of entity and attributes. Different kind of entity 

and attributes are store here.

 4. Relationship : It describes about the relationship of the entity which we are 

using.

 5. Relationship set : Many kind of  relationships are used in database but 

when same kind of relationship bring together at a place it is called 

relationship set.

Things to Remember
1. DBMS is a relational database management System.

2. Data are small raw materials such as character, numbers, pictures etc.

3. Database is a place where your data get store

4. DBA is the person or group of person who control the database system

5. To frequently  store an identical data again and again in database is called 

data redundancy. 

6. In ancient times to store Different set of records  in different-2 files is called file 

processing system.

7. Many Kinds of keys are use in relational database.

8. Normalization makes tables effective and structured.

9. SQL is a high level language which is used to store, control and amend the 

database.
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Exercise
1. Fill in the Blanks : 
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Introduction to MS-Access

5.1 Introduction to MS-ACCESS
Access 2010 is a Relational Database Management System (RDBMS). It is used for  

database creation and management. A relation is setup between different types of 

data which Provides a powerful environment to the user for building database. It can 

be used to track, Share and report Information. MS-Access Allow user to perform 

basic tasks such as opening and closing database, Creating tables, Forms , queries 

and Reports. If we Want to  understand Access, First we  must have to understand 

database.



In this lesson, we will get familiarize with the Access environment. we will learn 

about databases and how they are used with Access.

MS Access is the world's most popular desktop database. It is a part of the MS 

Office software suite. It is used in millions of corporate firms across the globe and in 

homes also. 

MS Access is used to store and retrieve large amount of data. It can be used for 

something simple such as keeping a record of your books  collection or for something 

larger such as invoicing/stock management. 

Some people get confuse between a spread sheet such as Excel and MS Access. A 

spread sheet is used to manipulate financial information. MS Access can also do this, 

but primarily it is a data storage system. 

Out of all the programs in the MS Office suite it is MS Access which has proven to 

be the stumbling block for many. But we can work on Access easily after a good 

training of MS Access.

5.2 Introduction to  Relational Database

Relational database was proposed by Edgar Codd (of IBM Research) around 

1969. Since then it become the dominant database model for commercial applications 

(in comparison with other database models such as hierarchical, network and object 

models). 

A relational database organizes data in tables (or relations). A table is made up of 

rows and columns. A row is also called a record (or tuple). A column is also called a 

field (or attribute). A database table is similar to a spreadsheet. However, the 

relationships that can be created among the tables enable a relational database to 

efficiently store huge amount of data, and effectively retrieve selected data.

MS-ACCESS is a relational database management system. Relational databases 

allow you to organize your data into tables; each table focuses on a specific topic; the 

various tables can then be linked to each other for inquery and reporting purposes.

5.3 Guidelines to design a Database

Before designing a database you must have to follow some guidelines. These 

guidelines will help you to create a great database.
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1. Identify all the fields needed by you  to produce the required information 

2. Organize each piece of data into its smallest useful part to make the design 

perfect.

3. Make group related fields into tables

4. Determine each table's primary key which will be uniquely identified.

5. You will have to Include a common field in related tables.

5.4 Some Technical Words of Access

Many technical terms are used in Access. Access arranges and divides database as 

under :

1. Database file : The database file is the main file of database which consists the 

whole data of the document. First of all you will ask to creat a database file in 

the beginning of the access document. The database file would be stored 

either on a hard disk or any other mean of storage devices.

2. Table : A table is the basic element of a Database and contains the data 

entered by users. Each row (or record) contains information about a particular 

item. The record is made up of several fields; each field contains one piece of 

information relating to the item (e.g., Student's name, roll no., address, phone, 

etc.). A database has many stored  tables.

3. Fields : A field is an individual set of data items that are of the same type. If 

we were to take an example of a class record to demonstrate this, the Class as 

a whole would be your database. It will have three fields. The roll no. is one 

field, the name is another and the marks is the third one. Each  as a unit would 

be a record, as a record it is a set of fields with data related to each other. You 

would have a field for each piece of data that you want to store as part of the 

record. A table consists of many fields.

 Example : 

 1. Student Name

 2. Student Address

98



4. Data Types : Databases consist of tables, tables consist of fields and fields are 

of a certain data type. A field's data type determines what kind of data it can 

hold. Every database has data types for text, integers (integers are whole 

numbers, i.e. numbers without a fraction) and decimal numbers and so does 

Access. But Access also has some data types that are specific to Access, like the 

Hyperlink, Attachment and Calculated data type. We will use different kind 

of data types for the desired field. 

 Example :

 1. The data type of Student Name is Text.

 2. The data type of Student Roll no is number.

5.5 Components of MSAccess

While creating database file, a file format box is opened. To the left hand corner of 

this box the following file format are seen :

1. Table : Tables are the data storage facilities in MS Access. As much as possible 

of a table design should be done in advance on paper. Here, however, you will 

be creating the table on the screen so that you can see the stages as they are 

implemented. Each table contains rows called records and columns called 

fields. A record is a collection of facts about a particular person or an 

organization. Each record in a table should be unique.. A field is a single kind 

of fact that may apply to a person or to an organization

2. Queries : A query that copies or changes data. Queries include append, delete, 

make-table, and update queries. They are identified by an exclamation point 

(!) next to their names in the Database window Crosstab query: A query is that 

calculates a sum, average, count, or other type of total on records, and then 

groups the result by two types of information : one down the left side of the 

datasheet and the other across the top Database window.  A query that asks a 

question about the data stored in your tables and returns a result set in the 

form of a datasheet, without changing the data

3. Forms : Forms provides us  friendly environment to view the data in which it 

shows a single record at a time. Forms can also be used to display results from 

queries. They are also used to facilitate data input. In forms we change our 
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data too. We can update or delete our data easily while using forms. It is the 

best way for the user to connect them with their tables.

4. Reports : Reports provide a means of organizing and summarizing data. 

Reports are often used to present an overview highlighting main points and 

trends. A report can be a simple list, a student's report or a school report. With 

reports, one can prepare :  Mailing labels for various producers - Produce a 

directory - Prepare invoices - Present data summaries. A report is made from 

the data available. There are several ways of preparing a report.

6. Macros : Macro is an automatic action that should be performed to an object of 

the data. It allow users to save their work automatically. Access allows users 

to do an easy and visual mechanism to make and manage macros. 

7. Modules : A module is collection of procedure statement and declaration 

which are stored as unit. Module are very similar to macros. Generally 

modules are of two types. They are used to do the advanced functions of 

database, for example to examine the data in complicated situations.

5.6 Data Types
One important setting for fields is the data type, which could be a number, text, 

currency, and date/time. The data type limits and describes the kind of information 

in the field. The data type also determines the actions one can perform on a field and 

how much memory the data will use. Fields also have properties that control the 

details of information inside them, including a character length, a default value, and 

a validation rule that makes sure the data meets certain criteria

In access many types of data types can be used . the data type is decided before 

creating a table. We know there are different data types of table. Some of the 

important data types of access are given below :

Data types Size/Format

Text Up to 255 

characters

Storage Capacity

Text  -  inc luding 

numeric text  (eg 

phone numbers)

Functions

Text consists  of  digits/ 

numbers, letters or their 

combination. It can have 

maximum of 255 letters. 

Numbers also been use as 

text only those numbers 

w h i c h  a r e  n o t  u s e d  i n 

mathematical calculations are 

included in text.
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Data types Size/Format

Number Long Integer 

Integer   

Single and 

double bytes 

Date/time General 

Yes/no Yes/No 

True/False 

On/Off 

Currency  Currency 

Scientific, 

percentage

Auto N.A

Number

Memo  Up to 65535 

characters  

OLE N.A

Object

Hyperlink N.A 

Calculated N.A 

Storage Capacity

Whole numbers

Both date & time - 

e . g .  2 5 / 1 2 / 1 5 

15:35:10 

N.A 

Up to 15 figures

 

Automatic counter - 

incremented by 1 for 

each record 

Longer pieces of text 

For pictures, sound, 

video, Word/Excel 

documents or any 

other docs.

N.A 

N.A 

Functions

Numbers been used only from 

the prescribed  size which we 

will declare in document. For 

e.g. If it is a byte we will use 

only whole positive numbers 

between 0 to 255.  

It is used for date and time. 

The data can vary from 100 to 

9999. it is 8 byte long 

For data with only 2 possible 

values. It is used for logical 

values. 

I t   c a n  a l s o  b e  u s e  i n 

mathematics or scientific 

functions. You can type only 

currency value in this type of 

fields. But you don't have to 

e n t e r  c u r r e n c y  v a l u e 

manually into your field. 

It is used in all numeric 

programs it automatically 

give increment to a number 

Memo is used in where we 

have to enter a longer text 

It is been used to insert 

p ic ture ,  sound,  v ideos , 

word/excel, documents and 

any other type of files which 

are supported by our system 

It is used For links to the 
WWW or e-mail  

This data type allow you to 
create a field that is based on 
a calculation of other fields in 
the same table
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5.7 Advantages of Access
1. Easy  installation  and work : Access gives data managers a fully functional, 

relational database management system. Like any other Microsoft 

applications, Access contains Wizards that helps you through each step of the 

program.

2. Easy to participate : Access works well with many of the developing software 

programs based in Windows like  Microsoft SQL Server and non-Microsoft 

products like Oracle and Sybase. You can easily participate in these programs 

with the help of ACCESS.

3. Popular RDBMS : Microsoft Access is the most popular desktop Relational 

database system in the world. Data can be viewed and sorted in many ways in 

Access.

4. Saves your money : Microsoft Access is more economical than other larger 

systems; offering the same functions and usage.

5. Convenient storage capacity : A Microsoft Access database can hold up to 2 

GB of data. Which is very convenient than to use the large storing capacity 

database software's.

6. Multi-user support : More About ten users in a network can use an Access 

application. It is a multiuser concept it helps to save our time. Data can be 

shared and edited by several users simultaneously

7. Importing data : Microsoft Access allow user to import their important data 

.Access makes it easy to import data from other sources.

8. Secure Database : MS access is secure database system information is secured 

which you have saved on it. It minimizes the duplication of data. It  increase 

accuracy and consistency.

5.8. Starting access

You can start access 2010 from the start menu (in windows 7) or by penning an 

existing access file. When you start the program without opening a specific file, the 

backstage view opens, prompting you to create a new database or open an existing 

database.

To start access 2010 from the start menu :

1. Click the start button, click all programs, click Microsoft office, and then click 

Microsoft access 2010. The new page of the backstage view opens, displaying 

thumbnails of the available templates and template categories.
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Fig. 5.1

2. Another shortcut way to open access is Press windows key with R it will open 
run command window as shown in the figure on Run command  type MS 
access is blank box.

Fig. 5.2

After  opening of MS access you have to click on the blank database available 
Under templates.

Fig. 5.3
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Click the create button. A blank database opens in the program window and a 

blank table named table1 opens in datasheet view.

Fig. 5.4 New table in a new database

5.9 Working with Tables 
A table is a database object that you define and use to store and update DATA. A 

table consists of records and fields. Every record contains data about one instance of 

the subject. EVERY RECORD consist of one or more fields. Each field contains data 

about one table subject because other database objects depend so heavily on tables

In datasheet view, a table looks similar to an excel worksheet in that data is stored 

in ROWS (records) and COLUMNS (field) as shown in the following diagram 

Fig. 5.5

When the active object is a table, the table tools contextual tabs (fields and 

table) become available on the ribbon so that you can work the table (see figures 5.6, 

5.7).

Field Name

Record

Field 
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Fig. 5.6. Table tools field tab

Fig. 5.7. Table tools table tab

5.10 Creating and Modifying tables
When you create a new table, you have complete control over the number of 

fields, the names of the fields, and what sort of data they can store. You can create a 

new table in the either datasheet view or design view by using the commands in the 

tables group on  the ribbon (see figure 5.8). which view you  want to start in, you can 

always switch to the other view by using the view button on the ribbon.

Fig. 5.8. Table group on the create tab

5.10.1 Creating tables in datasheet view 

In datasheet view, you can enter data into a new table without first defining the 

table s structure To create a table in datasheet view :

1. On the create tab, in the tables group, click the table button. A new  blank 

table opens in the object window in datasheet view (see figure 5.9).
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Fig. 5.9. Blank Table object window

Adding fields by entering data : Entering data in datasheet view is very similar 

to entering data in an excel worksheet. The main restriction is that data must be 

entered in contiguous rows and columns, click on the upper- left corner of the 

datasheet. The table structure is created while you  enter data. whenever you add a 

new column to the datasheet, a new field is defined in the table.

In every new table created in datasheet view, access automatically creates the first 

fields which is called id in the left column of the datasheet (see figure 7). By default, 

this field is designated as the table’s primary key . You can add a new field to the 

table by entering data in the click to add click to add column (the last COLUMN) of 

the datasheet.

Fig. 5.10. First record in a new table before Data is entered

To add a field by entering data   

1. Click in the first cell in the click to add COLUMN, ENTER the first item of 

data for the new record, and then press the tab or enter key to move the first 

cell in the column to the right. Access AUTOMATICALLY ASSIGNS the value 

1 to the id field. The icon on the row selector changes every time to a pencil 

ID Field Field 

New Record Active cellRow selector 
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WHEN THE record has been changed, but has not yet been saved (see figure 

5.11).

Fig. 5.11. First record in a new table after Entering Data

2. Click the pencil icon in the row selector. This saves the first record with the 

value 1 assigned to the id field; subsequent records will be numbered 

sequentially. 

3. Continue entering items of data in consecutive cells, and pressing the tab or 

enter key.

4. When you finish entering all the data for the first record, click anywhere in the 

row below to save the record.

After entering so many records as per your requirement you have to save the 

table

5.10.2 Creating Tables in design view

When you create a table in Design view, you have more control over the 

databases design. You first create the table’s structure in Design view, and then you 

switch to Datasheet view to enter data.

In Design view, the Object window consists of two panes (see Figure 5.12). The 

field Entry pane, located at the top of the window, is used to enter each field’s name, 

data type, and description. The field properties pane, located at the bottom of the 

window, is used to specify the field’s properties. The properties available in the Field 

properties pane depend on the data type assigned.

To create a table in Design view :

1. On the create tab, in the Table Design button. A New, blank table opens in the 

object window in Design view (see figure 5.12).
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Field Properties Pane 

Field Entry Pane 

Fig. 5.12. New table in design view

2. In the field name column, type a name for the first field. Field names can be up 

to 64 characters long. They can include any combination of letters, numbers, 

spaces, and brackets etc.

3. In the data type column click the down arrow and select a data type from the 

list (see figure 5.13).

 Fig. 5.13. Data type list    

Fig. 5.14
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4. In the description column, type a description for the field.

5. Repeat steps 2 through 4 to add additional fields to the table. After entering 

the all fields save the table.

5.10.3 Setting a primary key

A primary key consists of one or more fields that uniquely identify each record in 

the table there are several advantages to setting a primary key. First, the primary key 

automatically indexed, which makes information retrieval faster. Second, when you 

open a table, the records are automatically sorted in order by the  primary key. 

Finally, a primary key prevents the entry of duplicate data.

Access automatically creates a primary key for you and assigns it a field name of 

ID and the auto number data type. In design view, you can change or remove the 

primary key, or set the primary key for a table that does not already have one.

To set a primary key follow these steps :

1. Click the row selector of the field you want to designate as the primary key. 

2. In the design tab, in the tools group, click the primary key button (see figure 

5.15). A key icon appears to the left of the field that you specify as the primary  

key.

Fig. 5.15. Tools group on the Design tab

Fig. 5.16. Table after settings a primary key

5.10.4 Saving tables

After you create or modify a table, you should save it. When you save a table for 

the first time, you should it a name that describes the data that it contains. 

To save a table for the first time :

1. On the quick access toolbar, click the save button. The save as dialog box 

opens (see figure 5.17)

2 In the table name box, type a name for the table. 
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3. Click the ok button. The table appears in the tables list in the navigation pane.  

Fig. 5.17. Save As dialogue box

5.10.5 Closing database

When you finish working on a database, you should close the file. If the database 

contains any unsaved object, you will be prompted to save the object before closing 

the file.

To close a database :

1. Click the file tab, and then click close database.

5.10.6 Exiting access

When you finish using access 2010, you should exit the program to free up system 

resources. 

To exit access 2010 :

1. Click the file tab, and then click exit. Or, click the close button in the upper-

right corner of the program window.

2. Another option is to exit Access is Press ALT+F4 key together. With this 

option you will exit from access  in very easy way

5.11 Creating And Modifying Forms
Forms are used for entering, modifying, and viewing records. You probably have 

had to fill out forms on many occasions, like when visiting a doctor’s office, applying 

for a job, or registering for school. The reason forms are used so often is that they’re 

an easy way to guide people into entering data correctly. When you enter 

information into a form in Access, the data goes exactly where the database designer 

wants it to go: into one or more related tables.

5.11.1 Creating forms

Forms is a graphical representation of a table, in which we used can insert new 

data , change the present data or even can delete it. Forms and tables use similar data. 

Whenever we change any record in form, it will automatically change in table. The 

forms are most useful when we enter data according to field number. It is always very  
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5.11.2 Create a form to display your data 

Although it is possible to keep entering data into your table via the datasheet or 

table view, it is better to do it via a nice looking screen. 

To create a quick screen in MS Access 2010 simply go to the navigation pane and 

click to highlight the table you wish to base the form on. For example here I have 

clicked on the Students  table.

Now head up to the ribbon and click on the create tab. 

In the forms section click on the button named ‘Form’. (See figure 5.18) 

Fig. 5.18

MS Access creates a nice simple form. Click on any of the text boxes to position 

the cursor and edit the data.

Fig. 5.19

At the bottom you have navigation buttons to move you from one record to 
another record

5.12 Sorting
The records, as you have seen them so far, are shown in the order that they were 

first entered into the database . For this reason, it wouldn’t have been easy to search a 
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record you  simply done it  by scrolling through the records . Access sorts records by 

their ID numbers. However, there are many other ways records can be sorted. For 

example, the information in a database belonging to a Class could be sorted in 

several ways :

å� Result could be sorted by Name or by the marks of the students who were 

appered in exam

å� Students  could be sorted by name or by the roll no.

å� Students could be sorted by class.

You can sort both text and numbers in two ways: in ascending order and 

descending order. Ascending means going up, so an ascending sort will arrange 

numbers from smallest to largest and text from A to Z. Descending means going 

down, or largest to smallest for numbers and Z to A for text. The default ID number 

sort that appears in your tables is an ascending sort, which is why the lowest ID 

numbers appear first.

Steps to sort student table are as follows :

1. Select a field in the cell you want to sort by. In student table, we will sort by 

student name.

Fig. 5.20

2. Click the Home tab on the Ribbon, and locate the Sort & Filter group.

3. Sort the field by selecting the Ascending or Descending command.

 (a) Select Ascending to sort text A to Z or to sort numbers from smallest to 

largest. We will select this in our example because we want the names to 

be in A-to-Z order.
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     (b) Select Descending to sort text Z to A or to sort numbers from largest to 

smallest.

Fig. 5.21

4. The table will now be sorted by the selected field.

5. To save the new sort, click the Save command on the Quick Access toolbar. 

Fig. 5.22. Save

After you save the sort, the records will stay sorted that way until you perform 

another sort or remove the current one. To remove a sort, simply click the Remove 

Sort command.

Fig. 5.23. Remove Sort Command
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5.13 Filtering Data
Filters is the concept in MS-Access which allow you to view only the data you 

want to see. When you want to create a filter, you have to  set criteria for the data 

you want to display. The filter then searches all of the records in the table, finds the 

ones that meets your search criteria, and temporarily hides the other data.

Filters are useful because they allow you to look upon  on specific records 

without any distraction by the uninterested data. For instance, if you had a database 

that included Students  and Results  information, you could create a filter to display 

only students pass within a certain class or only students of a particular class. 

Viewing this data with a filter would be far more convenient than searching for it in a 

large table.

Follow these steps to apply filter:

5.13.1 To create a  filter

1. Click the drop-down arrow next to the field you want to filter by. We will 

filter by class because we want to see a list of students who were pass or fail in 

the desired class by you

Fig. 5.24

2. A drop-down menu with a checklist will appear. Only checked items will be 

included in the filtered results. Use the following options to determine which 

items will be included in your filter :

  Select and deselect items one at a time by clicking their check boxes. Here, å�

we will deselect all of the options except for Class .

  Click Select All to include every item in the filter. Clicking Select All a å�

second time will deselect all items.
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  Click Blank to set the filter to find only the records with no data in the å�

selected field.

Fig. 5.25

3. Click OK. The filter will be applied. Our Student table now displays only class 

9 record. 

5.14 Creating Reports
Reports : Reports in Access allow you to print assembled data in a custom layout. 

You can create reports based on tables and/or queries. 

There are several methods for creating a report. We will focus on the Reports 

wizard. 

To create a report :

1. Click on the Create tab and then select Report Wizard from the Reports group. 

Fig. 5.26
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2. The Report wizard launches.

Fig. 5.27

3. Click on the down arrow beside the Tables/Queries selection window and 

choose the table or query you’re basing your report on. (NOTE : You can select 

more than one table/queries. Repeat the step to add any additional 

table/queries.

4. Add fields –

 All the fields from your selected tables/queries appear in the Available Fields: 

window. 

  Use the button           to add fields to the Selected Fields window, one-at-a-å�

time. 

  Use the button          to move all available fields into the Selected Fields å�

window at once. 

  To remove individual fields from Selected Fields, click on each field and å�

press         . 

  To remove all fields, press           . å�

Note : The order in which you add fields to the Selected Fields window 

determines their default order in the report. 

å� When done, click Next. 
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5.14.1 Create grouping levels 

 If desired, use the right arrow button to create grouping levels (group your 

report listing by a category or categories), and use the up and down arrow buttons to 

promote or demote a field's position. The left arrow button removes selected fields 

from grouping levels.

Fig. 5.28

 When done, click Next. 

5.14.2 Sort by category (field) 

You can select a sort order for up to four fields. Click on the down arrow to select 

a field and then choose ascending or descending order. 

 When done, click Next.

Fig. 5.29
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5.14.3 Choose a layout 

Choose from the various layout options and click Next. 

Choose a page orientation – portrait or landscape.

Fig. 5.30

5.14.4 Assign a title 

 Enter a title for your report, or stick with the default title assigned by Access. 

Make sure that Preview the report is selected and click Finish. 

Fig. 5.31
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The report appears in Print Preview. 

Note : Any changes to data in the source tables/queries are automatically 

updated in your report.

Fig. 5.32

Things to Remember

1. Access 2010 is a Relational Database Management System (RDBMS).It is used 
for  database creation and management.

2. The database file is the main file of database which consists the whole data of 
the document.

3. A table is the basic element of a Database and contains the data entered by 
users.

4. A field is an individual set of data items that are of the same type.

5. A query that copies or changes data. Queries include append, delete, make-
table, and update queries.

6. One important setting for fields is the data type, which could be a number, 
text, currency, and date/time.

7. Forms are used for entering, modifying, and viewing records.

8. You can sort both text and numbers in two ways: in ascending order and 
descending order.

9. Filters is the concept in MS access which allow you to view only the data you 
want to see

10. Reports in Access allow you to print assembled data in a custom layout.
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Exercise
1. Fill in the Blanks : 

 1. .......................... is a relational database management system.

  (a) (b)  (c)  (d) Excel Word Power point Access

 2.  is the main part of the database..........................

  (a) (b)  (c)  (d) Query Table Form Module

 3. One field is the collection set of .......................... .

  (a) (b)  (c)  (d) Database Tables Data items Forms

 4. Queries are used for tables to convert, ,  and .......................... ..........................

. ...........................

  (a) Store, Forms, Update

  For delete, Create table, Update(b) 

  (c) For Store, Paste, Copy

  (d) Copy Queries, Make modules, create reports

 5. Important setting for a field is called .......................... .

  (a) (b)  (c)  (d) Database Macro Data types Reports

2. Short Answer Type Questions :

 1. Write the name of components of M-S Access.

 2. Write datatypes that used in MS-Access.

 3. What do you mean by record ?

 4. What is table ? Name the different ways to create table.

 5. What do you mean by Form ?

 6. What is report ?

3. Long Answer Type Questions :

 1. What are the instructions to design database ? Explain it.

 2. Write different types of components of MS. Access. 

 3. What are the filters ? Write steps to implement it.

 4. What is sorting ? How do you implement it on your document ?
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Introduction of Internet Application
As we know that Internet is a worldwide collection of computer networks, 

cooperating with each other to exchange data using a common software standard. 

Through telephone wires and satellite links, Internet users can share information in a 

variety of forms. One can surf for any kind of information over the internet. 

Information regarding various topics such as Technology, Health & Science, Social 

Studies, Geographical Information, Information Technology, Products etc. can be 

surfed with help of a search engine.

 Apart from communication and source of information, internet also serves a 

medium for entertainment. For example Online Games, Songs Videos, Social 

Networking Apps etc.

 Internet allows us to use many services like Internet Banking, Online Shopping, 

Online Ticket Booking, Online Bill Payment, email etc.

Internet provides concept of electronic commerce that allows the business deals 

to be conducted on electronic systems

6.1 E-mail 

Email, short form "electronic mail," is one of the most widely used features of the 

Internet, along with the web. It allows us to send and receive messages to and from 

anyone with an email address, anywhere in the world.

Email uses multiple protocols within the TCP/IP suite. For example, SMTP is 

used to send messages, while the POP or IMAP protocols are used to retrieve 

messages from a mail server. When we configure an email account, we must define 

our email address, password, and the mail servers used to send and receive 

messages. Fortunately, most webmail services configure our account automatically, 

so we only need to enter our email address and password. Some of the webmail 

services are Gmail (Google Mail), Yahoo mail, Rediff mail, Hotmail etc.

Fig. 6.1. E-mail
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6.1.1 Gmail

'Google Mail' or 'Gmail' is a free email service provided by Google. In many 

ways, Gmail is like any other email service: You can send and receive emails, block 

spam, create an address book, and perform other basic email tasks. But it also has 

some more unique features that help to make it one of the most popular email 

services on the Web.

6.1.1.1 Creating new account

In this , we'll study about how to get started with email by creating an account in 

Gmail.

Note : We are using Chrome as our browser, however other browsers such as 

Internet Explorer and Firefox will look similar. 

Follow these step-by-step instructions to create a Gmail account

å� Open up the internet browser.

å� Type address.

Fig. 6.2. Gmail

Note : Or Click on “Gmail” link at the top right corner of the google home page.

Fig. 6.3. Google Home Page
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 We'll now be in the 'Sign in' section.

Fig. 6.4. Create New Account and Sign In

 As we don't have a Google account yet, we need to create one. Click Create an 

account.

To set up our new account, Google needs some information about us  

å� Our first and last names. 

å� The 'choose our username' is the unique email address that we wish to use, 

which will be placed before '@gmail.com'. Because it needs to be unique, 

Google may have to check the availability of any name that we decide on to 

make sure that no one already has it. Type an email name into the 'choose our 

username' box .Once we finalise our email address, it's a good idea to make a 

note of it so that we can refer to it until we remember it. 
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Fig. 6.5. Set Up Our New Account

å� We'll need to give  a password so that we can log in securely to our account. 

Google may explain that we should try one with at least 8 characters long to 

be secure. Use letters and numbers to make the password more secure and 

difficult to guess. We'll need to re-enter our password to ensure that it's we 

choosing it and not a hacker's robot. This is why it also asks us to insert two 

random words at the bottom of the page  this is a CAPTCHA code. We can 
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skip this step if we don't want to type in the CAPTCHA code but we will need 

to verify via a mobile phone if we don't.(Captcha Code is described ahead in 

section 6.1.2)

å Then fill your birth date (Month, Day, Year)

å Fill your Gender(Male/Female)

å Mobile phone number and any other e-mail address(if exist)

 Once we have completed this page fully, clicking Next Step will take us to the 

next Page. 

Fig. 6.6. Continue to Gmail

We will now have set up our account.

Click “Continue to Gmail” to go to our inbox and get started.

6.1.2 Captcha Code

A CAPTCHA (an acronym for "Completely Automated Public Turing test to tell 

Computers and Humans Apart") is a type of  test used in computing to determine 

whether or not the user is human.

A CAPTCHA is a program that protects websites by generating and grading tests 

that humans can pass but current computer programs cannot. For example, humans 

can read distorted text as the one shown below, but current computer programs can't.

CAPTCHA
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6.1.3 How to send and receive E-mail?

To send an email, click "Compose Mail" located above the folder list. An entry 

form appears in the Gmail interface. 

 

Fig. 6.7. Compose Mail

Fig. 6.8. Send Mail
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The recipients : In the "To:" box, type the address of the person we want to write 

to. For multiple recipients, separate the addresses with commas.

To view the "Cc:" tab click "Add Cc". Cc means "carbon copy", type here the 

addresses of people who are not the main recipients of the message, but we still want 

to send a copy to. 

To view the "Bcc:" tab click "Add Bcc". Bcc stands for “Blind carbon copy ”, type 

here the addresses of people we want to send a copy of the mail to, without the other 

recipients knowing. 

The subject

In "Subject:", enter the subject of the email. Enter the text itself. By default, Gmail 

will send a message in HTML format. 

When we finish typing our mail, click the "Send" button to send it immediately or 

on the "Save" button to save as draft.

We'll see that sending emails is a really easy process. 

 Reading our mails : All emails received are stored in the inbox. The number of 

unread messages is indicated in brackets to the right of the "Inbox" folder. Gmail 

automatically checks every two minutes when new messages arrive. 

By default, a single message is summed up in one line :

å� Dispatcher

å� Subject

å� The first words in the text

å� The date (or time) to dispatch

Fig. 6.9. Reading our mails
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6.1.4 How to attach file(s)with email message

In the new message window, click the paperclip icon to add an attachment. Find 

and click on the folder or files we wish to attach, then click "Open" and we should see 

the attachment added to our message. In the most recent versions of browsers like 

Chrome and Firefox, we can also simply drag and drop files into Gmail's Compose 

window  to upload an attachment.

Fig 6.10. Window To Upload  An Attachment

6.2. Google Apps
Apps is an abbreviation for application. An app is a piece of software. It can run on 

the Internet, on our computer, or on our phone or other electronic device. The word 

"app" is a more modern usage, but this is really the same thing as a program. 

Google refers to their online services as apps, but they also sell a specific suite of 

services known as Google Apps 

Fig. 6.11. Google App Link
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Google Apps is a suite of Web-based applications from Google that includes e-

mail, calendar, word processing, spreadsheet and presentations. 

 Fig. 6.12. Google Apps 

6.2.1 Google Calendar

Google Calendar is a time-management web application and mobile app created 

by Google. Users are required to have a Google Account in order to use the 

app.Google Calendar allows multiple calendars to be created and shown in the same 

view. Each can be shared, either read-only or with full edit control, and either with 

specified people or with everyone (public calendars). 

Fig. 6.13. Google Calendar
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6.2.2 Google Maps

Google Maps is a desktop web mapping service developed by Google. It offers 

satellite imagery, street maps, 360° panoramic views of streets (Street View), real-

time traffic conditions (Google Traffic), and route planning for traveling by foot, car, 

bicycle (in beta), or public transportation.

Fig. 6.14. Google Maps

6.2.3 Translate

Google Translate is a free multilingual statistical machine translation provided 

by Google to translate text, speech, images, or real-time video from one language 

into another.

Fig. 6.15. Google Translate
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6.2.4 Google+

Google+ (Google Plus) is Google's attempt at social networking. The Google+ 

service that delivers functionality and many features similar to those of Facebook. 

Features in Google+ include "Posts" for posting status updates, "Circles" for 

sharing information with different groups of people (like Facebook Groups), "Sparks" 

for offering videos and articles users might like, and "Hangouts" and "Huddles" for 

video chatting with a friend or group of friends.

Fig. 6.16. Google +

6.2.5 Google Docs

Google Docs is an online word processor that lets you create and format text 

documents and collaborate with other people in real time

Fig. 6.17. Google Docs

6.2.6 Google Sheets

Google Sheets is an online spreadsheet app that lets you create and format 

spreadsheets and simultaneously work with other people.

Fig. 6.18. Google Sheets
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6.2.7 Google Slides

Google Slides is an online presentations app that allows you to show off your 

work in a visual way. 

Fig. 6.19. Google Slides

Fig. 6.20. Google Docs

6.2.8 Play Store

Google Play is Google's online store for purchasing and downloading apps, 

music, books, movies and similar content for use on Android-powered smartphones, 

tablets, Google TV and similar devices. The Google Play store, which comes pre-

installed on Android devices, allows users to purchase, download and install 

applications from Google and third-party developers.  

Fig. 6.21. Play Store
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6.2.9 Google Drive

Google Drive is a service offered by Google that allows us to store and share files 

online. The service was launched on April 24, 2012 and provides 5 GB of free storage. 

Additional storage can be purchased for a monthly fee.

Fig. 6.22. Google Drive

6.2.9.1 Benefits of Google Drive

1. Google Drive lets us send large files to our colleagues, clients and friends 

directly from our Gmail account. 

2. Google Drive allows us to access our files remotely. With Drive, all our files 

become available on the web. 

3. Google Drive has its own mobile application which gives us access to our 

files on our iPhone or smartphone, no matter where we are!

4. Google Drive has an efficient built-in search engine which allows us to find 

content easily with a keyword search. We can also look for files by owner or 

by file type.

5. Google Drive is equipped with an OCR (optical character recognition) 

function, which allows us to search for words or expressions in scanned 

documents. For example, finding someone's name in an old newspaper article 

that was scanned and saved on Google Drive is possible .

6. Google Drive allows users to open various types of files, like.ai (Adobe 

Illustrator) and even .psd (Photoshop) files.

7 .Main Benefit- All the facilities described above are free.

Note : On Google Drive, our data can't get lost, no matter what we do to our 

computer?

6.2.9.2 How to share file(s)?

1. Open Drive, or a file or folder we want to share.

2. Open the sharing box :

  While we have a file open : Click Share in the top-right corner.å

  While we have a folder open : Click the share icon in the top-right.å
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 From our file list in Drive : Select the name of a file or folder and click the 

share icon at the top .

3. Under “People” in the sharing box, type the email addresses of the people or 

Google Groups we want to share with. We can also search for contacts by 

typing them into the box.

4. Choose the type of access we want to give these users by clicking the 

dropdown arrow to the right of the text box:

Can edit : Users can edit the file or folder and share it with otherså�

Can comment : Users can view and add comments to the file, but can't edit å�

it. Folders can't be given comment access.

Can view : Users can see the file or folder but can't edit or comment on itå�

5. Click Done. The users will receive an email letting them know we've shared 

the file or folder with them.

Fig. 6.23. Share file

6. If we want to share multiple files at once, add the files to a folder in Drive and 

then share the entire folder with the people we want to see the files.

6.3 How to download software's
Downloading is how we copy a file from a website to our computer, tablet, or 

device. An upload is when we send a file to a website. Downloads are mostly used 

for program installations, apps, documents, and anything else that we need a local 

copy of. Uploads are mostly used for sending documents.

The same basic steps apply to most downloads :

å� Click the link.

å� Choose open or save.

å� Confirm the download.

å� run or open the download.
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6.4 Internet in Media
TV, radio, and the Internet used to be completely separate things, but that's no 

longer true with today's technology. We can now watch TV shows on our computer, 

and we can connect to the Internet on many TVs and DVD/Blu-ray players. In 

addition, radio stations from around the world allow us to listen online, and many 

online radio stations now exist.

6.4.1 On Line Newspaper

Online newspaper is the online version of a newspaper, either as a stand-alone 

publication or as the online version of a printed periodical. Going online created 

more opportunities for newspapers, such as competing with broadcast journalism in 

presenting breaking news in a more timely manner.

Fig. 6.24 On Line Newspaper

6.4.2 Online TV channels, Radio, Live programs(Streaming Media)

TV and radio on the Internet are examples of streaming media, which means the 

media downloads while it's playing so we don't have to wait for it to download 

first. Our smartphone or computer.

Fig. 6.25. Online TV channels, Radio, Live programs(Streaming Media)
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Online radio is the distribution of audio broadcasts over the Internet. There are 

thousands of Internet radio stations that can be streamed to a software media player 

in a computer, mobile device, stand-alone Internet radio, media hub or media server. 

Often called "Webcasts," they come from several organizations as well as traditional 

AM and FM radio stations. If an Internet radio has built-in wireless connectivity, it 

may be called a "Wi-Fi radio."

The number of online TV services is growing by the day, and every time we wake 

up there seems to be dozens more ways to enjoy our favorite programs. For example 

we can listen live kirtan from Harmandir Sahib (Amritsar Punjab) on our 

smartphone or computer

Fig. 6.26. Live TV services

6.5 Cloud Networking
What is Cloud ?

The term Cloud refers to a Network or Internet. In other words, we can say that 

Cloud is something, which is present at remote location. Cloud can provide services 

over public and private networks, i.e., WAN, LAN or VPN.

Fig. 6.27Cloud Networking

Storage 

Application
Intrastructure 
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Applications such as e-mail, web conferencing, customer relationship 

management (CRM) are executes on cloud.

Cloud networking refers to manipulating, configuring, and accessing the 

hardware and software resources remotely. It offers online data storage, 

infrastructure, and application.

Cloud networking offers platform independency, as the software is not required 

to be installed locally on the PC.  In cloud networking it is simple to add more stuff. 

Cloud networking  provides the ability to scale up and down when additional users 

are added and when the application requirements change.

6.5.1 Unique IP Address

Every machine on the Internet has a unique number assigned to it, called an IP 

address. Without a unique IP address on our machine, we will not be able to 

communicate with other devices, users, and computers on the Internet. We can look 

at our IP address as if it were a telephone number, each one being unique and used 

to identify a way to reach us and only us.

An IP address always consists of 4 numbers separated by periods, with the 

numbers having a possible range of 0 through 255. An example of how an IP address 

appears is : 192.168.1.10

This representation of an IP address is called decimal notation and is what is 

generally used by humans to refer to an IP address for readability purposes. With the 

ranges for each number being between 0 and 255 there are a total 4,294,967,296 

possible IP addresses.

Out of these addresses there are 3 special ranges that are reserved for special 

purposes. The first is the 0.0.0.0 address and refers to the default network and the 

255.255.255.255 address which is called the broadcast address. These addresses are 

used for routing. The third address, 127.0.0.1, is the loopback address, and refers to 

our machine. Whenever we see, 127.0.0.1, we are actually referring to our own 

machine.  

6.5.2 Cloud Printing

Wouldn't it be easier if we can connect all our devices  including our tablets and 

phones  to one particular printer and print straight from any one of the devices, 

from anywhere, as long as we're connected to the Internet?

Cloud Printing enable users to print documents and other materials on any 

device associated with the cloud(network). Users create content with any software 
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tool they want and transfer the file to a cloud printing service provider via whatever 

device they choose, which then routes the file to a cloud-attached printer at a location 

selected by the user. 

Fig. 6.28. Cloud Printing

6.6 Internet Security
The Internet provides a wealth of information and services. Many activities in our 

daily lives now rely on the Internet, including various forms of communication, 

shopping, financial services, entertainment and many others. The growth in the use 

of the Internet, however, also presents certain risks. Just think about all the 

information we send over the Internet, such as personal messages, bank account 

information, photographs, etc.

As a typical Internet user, we have the reasonable expectation that our 

communications and transactions are private and secure. When we make a video call 

to a family member, we expect that nobody else is watching. When we buy 

something online with a credit card, we expect that nobody else can get access to our 

credit card details.

The Internet is indeed private and secure, but there are a number of serious 

security risks. 

6.6.1 Virus/Anti-virus

A computer virus is a computer program that replicates itself into other computer 

programs and can cause damage to a computer's software, hardware or data. Once a 
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virus is present on a computer, it typically performs some type of harmful action, 

such as corrupting data or obtaining sensitive information. 

Fig. 6.29. Virus

The best way to deal with the threat of a computer virus is to use antivirus 

software. Antivirus software helps to protect a computer system from viruses and 

other harmful programs. One of the most common ways to get a virus on our 

computer is to download a file from the Internet that is infected. Antivirus software 

scans our online activity to make sure we are not downloading infected files. 

Antivirus software also helps to detect and remove viruses from our computer 

system if we do get infected.

6.6.2 Spyware

Spyware is a program installed on our computer that sends information about us 

and how we use our computer to a third party, typically without  being aware this is 

happening. Spyware often enters our system when we install some type of free 

software from an untrusted source. Since we authorized the installation, 

conventional protection methods, such as antivirus software, do not prevent spyware 

from getting installed in this manner.

Once the spyware program is installed, it starts collecting information. Some 

spyware programs are relatively harmless and collect very generic information that 

does not personally identify us. Other spyware programs may record our actual 

keystrokes, including any passwords, and may search through any of our files 

looking for something that looks like a credit card number. These types of spyware 

programs can definitely be harmful.

Once spyware has collected its information, it sends this to whoever created the 

program. Again, this happens without any notice. Removing the spyware can be 
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difficult - often the program installs itself again as quickly as we can delete it. To 

counter spyware, we need to use a dedicated spyware management tool. Some 

antivirus software are bundled with spyware management tools, but they are 

separate functions.

6.6.3 Trojan 

A Trojan horse, often shortened to Trojan, is a type of malware designed to 

provide unauthorized, remote access to a user's computer. Trojan horses do not have 

the ability to replicate themselves like viruses; however, they can lead to viruses 

being installed on a machine since they allow the computer to be controlled by the 

Trojan creator. The term gets its name from the Greek story of the Trojan War, when 

the Greeks offered the Trojans a peace offering in the form of a large wooden horse. 

However, once the Trojans wheeled the horse behind their closed gates and night 

fell, the soldiers hidden inside the horse climbed out and opened the city gates, 

allowing the Greek army to infiltrate Troy and capture the city.

Fig. 6.30. Trojan

Trojan horse software operates the same way, where Trojan is our computer and 

the horse is the benign-seeming application. 

6.6.4 Phishing Scams

Phishing is an e-mail fraud method in which the wrongdoer sends out legitimate-

looking email in an attempt to gather personal and financial information from 

recipients. Typically, the messages appear to come from well-known and 

trustworthy Web sites. The message tricks people into providing sensitive 

information, such as their login details. A typical scam consists of a message that 

describes some issue with our account and requires us to login to our account to 

confirm something. The message looks very official, using logos and formal 

language, just like we would expect from a genuine source.  When we follow the 
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link, the webpage looks very real - but if we look closely, the Internet address is 

actually not the official one.

Fig. 6.31. Phishing Scams

Financial institutions don't send out these types of messages. Don't follow the link.

6.6.5 Digital Signature

 The centuries-old means of documenting transactions and creating signatures are 

changing fundamentally. Documents continue to be written on paper, but sometimes 

merely to satisfy the need for a legally recognized form. In many instances, the 

information exchanged to effect a transaction never takes paper form. It also no 

longer moves as paper do; it is not physically carried from place to place but rather 

streams along digital channels at a speed impossible for paper.  Paper documents can 

be read efficiently only by human eyes, but computers can also read digital 

information . The basic nature of the transaction has not changed; however, the 

transaction's form, the means by which it is represented and affected, is changing. 

Digital signature technology generally surpasses paper technology.

Digital Signature is a digital code which is attached to an electronically 

transmitted document to verify its contents and the sender's identity.

Fig. 6.32. Digital Signature

Digital signatures are created and verified by means of cryptography, the branch 

of applied mathematics that concerns itself with transforming messages into 
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seemingly jumbled or meaningless forms and back again. For digital signatures, two 

different keys are generally used, one for creating a digital signature  and another 

key for verifying a digital signature.

Things to Remember
1. E-mail allows us to send and receive messages to and from anyone with an 

email address, anywhere in the world.

2. A CAPTCHA  is a type of  test used in computing to determine whether or not 

the user is human.

3. All emails received are stored in the inbox.

4. Google Apps is a suite of Web-based applications from Google that includes e-

mail, calendar, word processing, spreadsheet and presentations. 

5. Every machine on the Internet has a unique number assigned to it, called an IP 

address.

6. Cloud networking refers to manipulating, configuring, and accessing the 

hardware and software resources remotely.

7. Cloud Printing enable users to print documents and other materials on any 

device associated with the cloud(network).

8. The Internet is indeed private and secure, but there are a number of serious 

security risks. 

9. Phishing is an e-mail fraud method in which the wrongdoer sends out 

legitimate-looking email in an attempt to gather personal and financial 

information from recipients.

10. Digital Signature is a digital code which is attached to an electronically 

transmitted document to verify its contents and the sender's identity.

Exercise
1. Fill in the Blanks : 

 1. .......................... 'Gmail' is a free email service provided by .

  (a)  (b)  (c)  (d) Yahoo Google Rediffmail Hotmail

 2. Every machine on the  Internet has a unique number assigned to it, called             

an .......................... . 

  (a)  (b)  (c)  (d) IP Address E-mail ID Address
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 3. A   is a type of  test used in computing to determine whether or ..........................

not the user is human.

  (a)  (b)  (c)  (d) CAPTCHA DERTSA HEPTCHA NEPHCA

 4. is a type of malware designed to provide unauthorized, remote .......................... 

access to a user's computer.

  (a)  (b)  (c)  (d) Spyware Trojan Malware Horse

 5. TV and radio on the Internet are examples of  media...........................

  (a)  (b)  (c)  (d) Streaming Limited Online Offline

2. True/False :

 1. Spyware is an e-mail fraud method in which the wrongdoer sends out 

legitimate-looking email in an attempt to gather personal and financial 

information from recipients.

 2. Google Drive does not allow us to store and share files online.

 3. The best way to deal with the threat of a computer virus is to use antivirus 

software.

 4. In BCC we type the addresses of people we want to send a copy of the mail to, 

without the other recipients knowing. 

 5. Digital signatures are created and verified by means of biography.

3. Short Answer Type Questions :

 1. What is a CAPTCHA code ?

 2. What do you mean by Google Apps ?

 3. What is Digital Signature ?

 4. Write the process of sending an e-mail.

 5. Write the basic steps of downloading.

 6. What is cloud printing ?

 7. Name four anti virus software.

4. Long Answer Type Questions :

 1. What is IP Address ? Explain.

2. Explain any three Google Apps.

3. Explain the process of creating an e-mail account in Gmail.

4. What are the benefits of google drive ?
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Objective of this Lesson
7.1 Introduction

7.2 Main characteristics of Good Governance

7.3 History and development of E – governance

7.4 E – governance

7.5 Objectives of E  governance

7.6 E – governance Models

 7.6.1 Government to citizens (G2C)

 7.6.2 Government to government (G2G)

 7.6.3 Government to employees (G2E)

 7.6.4 Government to businessman (G2B) 

7.7 Areas of E – governance

 7.7.1 E- Governance in urban areas

  7.7.1.1 Transportation

  7.7.1.2 Online payment of bills and taxes

  7.7.1.3 Information and public relation key services

  7.7.1.4 Municipal services

  7.7.1.5 Roads and traffic management

 7.7.2 E- Governance in rural areas

  7.7.2.1 Agriculture

  7.7.2.2 Local information

  7.7.2.3 Disaster management

  7.7.2.4 Land record management

  7.7.2.5 Panchayat

 7.7.3 E – Governance in Health

 7.7.4 E – Governance in Education

7.1 Introduction
Before we start learning e-governance, we must know about meaning of 

governance. The concept of "governance" is not new. It is as old as human 

civilization."Governance" means : the process of decision-making and the process by 
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which decisions are implemented. Various actors are involved in governance. An 

analysis of governance focuses on the formal and informal actors involved in 

decision-making and implementing the decisions. Government is one of the actors in 

governance. Other actors involved in governance vary depending on the level of 

government.

Fig. 7.1. Levels of Governance

Good governance is the processes of making and implementing decisions. It's not 

about making 'correct' decisions, but about the best possible process for making and 

implementing those decisions. 

7.2 Main characteristics of Good Governance
1. Good governance is answerable to the community, for the consequences of 

decisions it has made.

2. Good governance is transparent which means that people are able to clearly 

see how and why a decision was made.

3. Good governance follows the rule of law.

4. Good governance is responsive which means that government always tries to 

serve the needs of the entire community timely and appropriately.

5. Good governance is effective and efficient in implementing decisions and 

follows processes that make the best use of the available people, resources and 

produce results that meet the needs of society.

6. Good governance is participatory. Anyone affected by or interested in a 

decision have the opportunity to participate in the process for making that 

decision. This can be done in several ways such as by providing community 

members with information, ask for their opinion, given the opportunity to 
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make recommendations or, in some cases, be part of the actual decision-

making process.

7.3 History and development of E – governance
In India E-Governance originated during the seventies. At that time government 

adopted its applications in the areas of defense, economic monitoring and planning. 

The ICT was used to manage data related to elections, census, tax administration etc. 

After that, with the efforts of the National Informatics Center (NIC) all the district 

headquarters were connected during the eighties. From the early nineties, e-

governance has used IT for wider sectoral applications with emphasis on reaching 

out to rural areas.

Earlier, a talk between a citizen and the Government takes place in a government 

office. But with the advancement of Information and Communication technologies, 

work culture of government offices has enhanced. Information and Communication 

Technologies has made it possible to locate service centers near to clients. Such 

centers may consist of an unattended kiosk in the government agency, a service kiosk 

located close to the client outside the government agency, or the use of a personal 

computer at home or office.

In all the cases public traditionally look for information and services addressing 

his/her needs. In both cases quality and efficiency are of great importance. Therefore, 

the establishment of e-Governance requires a good knowledge of the needs that exist 

in the society and that can be offered using ICT.

Due to widespread demand of E-governance and exponentially increasing size of 

data, new technologies like Open source solutions and cloud computing need to be 

used in working of government. Today, electricity, water, phone and all kinds of bills 

can be paid over the internet. All these work is what government and citizens are 

using and doing. All this dependents on internet and when citizens depends on 

government internet services all that come is E-Governance.

7.4 E – governance:

Online working of a government or providing its services online to its citizens at 

their door step is known as E-Governance. In other words, E-Governance means 

online availability of government services. 

In today's world the development of any country depends on the uses of E-

Governance. E-Governance has made the working of government more efficient and 
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more transparent to its citizens. Success or failure of any government depends on 

three things : 

1. The way the government works. 

2. Transparency in its working and information.

3. Communication to its citizen.

In E-Governance, government makes best possible use of internet technology to 

communicate and provide information to common peoples and businessman.

There are four pillars of E-Governance :

1. CONNECTIVITY : Connectivity is required to connect the people to the 

services of the government. 

2. KNOWLEDGE : The knowledge here is referred to as IT knowledge. 

Government employs skilled engineers who can make it possible to work e-

governance in an efficient way. 

3. DATA CONTENT : To share information over the internet, government 

possesses its database which should have the data content related to 

government services. 

4. CAPITAL : Capital is referred to money used by government to provide their 

services.

7.5 Objectives of E – governance

The objective of e-governance is to support and simplify governance for all 

parties - government, citizens and businesses. In other words, in e-governance uses 

electronic means to support and encourage good governance. Therefore the 

objectives of e-governance are similar to the objectives of good governance.  

The two main objectives of e-governance are :

1. To satisfactorily fulfil the public's needs and expectations by simplifying their 

interaction with various online services. 

2. To facilitate a speedy, transparent, accountable, efficient and effective process 

for performing government administration activities. 

Here we can say that e-governance is more than just a Government website on the 

Internet. Political, social, economic and technological aspects are determined in e-

governance.
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7.6 E-governance models

E-GOVERNANCE services can be shared between citizens, businessman, 

government and employees. 

These four models of e-governance are as :

1. Government to citizens (G2C)

2. Government to government (G2G)

3. Government to employees (G2E)

4. Government to businessman (G2B) 

7.6.1 Government to citizens (G2C)

This model of e-governance refers to the government services which are shared 

by citizens. In this model, citizens visit to the links of services that they want to use. 

This model strengthens the bond between government and its citizen. Type of 

services which are provided by this model includes:- 

1. Payment of online bills such as electricity, water, telephone bills etc. 

2. Online registration of applications. 

3. Copies of land-record. 

4. Online filling of complaints. 

5. Availability of any kind of online information. 

7.6.2 Government to government (G2G)

This model refers to the services which are shared between the governments. 

There is lots of information that need to be shared between various government 

agencies, department and organizations. These types of services or information are 

as :

1. Sharing of information between police department of various state. 

2. Government document exchange which includes preparation, approval, 

distribution, and storage of all governmental documents, is also done through 

e-governance. 

3. Most of the finance and budget works are also done through e-governance. 
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7.6.3 Government to businessmen (G2B)

Through this model, bond between private sector and government is 

strengthened. It is used by businessmen to communicate to the government. Type of 

services which are provided by this model includes:- 

1 Collection of taxes. 

2 Rejection and approval of patent is done by this model. 

3 Payment of all kind of bills and penalty. 

4 Sharing of all kind of information, rules and data. 

5 Complaints or any kind of dissatisfaction can be shown by this. 

7.6.4 Government to employees (G2E)

This model increases the transparency between government and its employee. 

Here, employee can keeps a check on the functioning and working of government 

and government can keep track on its employees. Information that can be shared by 

this model :

1. All kind of data submission (attendance record, employee record etc.) from 

various government offices is done by this model.

2. Employee can file all kinds of complaints and dissatisfaction by this model. 

3. All kind of rule- regulation and information for employees can be shared by 

this. 

4. Employees can check their payment and working record. 

5. Employees can register all kind of working forms online. 

7.7 Areas of E  governance
Today area of e-governance is very wide. E-Governance is implemented by 

government in almost every field. From urban states to rural areas, e-Governance has 

spread its root everywhere. Either its public or private sector, common man or 

businessman all is largely dependent on e-governance. Here we will go through 

different areas where e-governance is widely used. In the following section, the 

projects used in urban and rural areas of India are stated :  

7.7.1 E-Governance in urban areas

7.7.1.1 Transportation

Services provided by e-governance in this area are :

1. Issue of learner licences, Issue of driving licenses, Renewal of driving licenses 

etc.
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2. To provide transport related facilities online.

3. For online bookings, cancellation of seats, for enquiry about departure of 

buses, availability of seats and buses etc.

4. Issuance of Time Table of buses. 

5. Provision of booking facility for Interstate transport. 

6. Transportation Improvement Program. 

7. Regional Transportation Plans. 

8. Congestion Management Process. 

9. Transportation Demand Management. 

å� Various projects such as 

1. IRCTC (Indian Railway Catering and tourism Cooperation ltd.) Offers online 

rail ticket booking, and checking of ticket reservation status. 

2. HRTC (Himachal Road Transport Corporation project) is for online bookings, 

cancellation of seats, for enquiry about departure of buses, availability of seats 

and buses etc. 

7.7.1.2 Online payment of bills and taxes

Services provided by e-governance in this area are :

1. Online Transactions such as payment of license fees, university fees, etc.

2. Payment of Bill such as online payment of electricity and water bills,utility 

bills, to avail of trade licenses and transact on government matters at these 

facilities.

3. Payment of taxes such as online payment of motor vehicle taxes, revenue 

taxes,

4. Payment of house EMIs.

å� Various Projects such as 

1. SAMPARK by Chandigarh government.

2. E-Suvidha by the government of Uttar Pradesh.

3. E-SEVA (Electronic seva) by Andhra Pradesh.

4. E-Mitra by the Government of Rajasthan 
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7.7.1.3 Information and public relation key services

With these kinds of projects people can get any kind of information with just a 

single click are as under :

1. Information about vacancies, tenders and market rates etc.

2. Village e-mail etc.

å� Various projects such as 

1. LokMitra by the government of Himachal Pradesh. 

7.7.1.4 Municipal services

Services provided are as :

1. House Tax Assessment, Billing and Collection. 

2. Maintaining records of Land & property. Certificates like Land sale 

Permission, Legal heir certificate.

3. Issue of Passport Verification Certificate. 

4. Issue of Death and BirthCertificates. 

5. Registration & Attorneys of properties such as computerization of the 

Document registration work at Sub Registrar Office.

6. Provide services such as issuance of certificates, issuance of orders in respect 

of Social Security Schemes such as old age pension, widow pension, freedom 

fighter pension etc. 

7. Review and approval authority for site plans 

å� Various projects such as

1. SDO Suite by Assam government. 

2. Rural Digital Services.

7.7.1.5 Roads and traffic management

Services provided by this type of e-governance is :

1. Network of Roads & Bridges.

2. Road construction and their maintenance.

3. Traffic Management.

4. Safety, Accident and pollution control.
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å Various projects such as 

1. RSPCB (Rajasthan State Pollution Control Board) by Govt. of Rajasthan.

7.7.2 Areas of e-governance in rural areas

In rural areas e-governance has its very powerful impact. Here, from agriculture 

to local information everything is done through e-governance. 

7.7.2.1 Agriculture

Following are the projects used in Agriculture. 

1. AGMARKNET : It is a project approved by Department of Marketing & 

Inspection (DMI), Ministry of Agriculture, and Government of India. 

2. SEEDNET : It is a SEED informatics network under ministry of Agriculture, 

Government of India.

7.7.2.2 Local information

For local information such as personal information, prices of seeds, fertilizers, 

loan rates etc. government has started e-governance service in this area also.

å� Various projects such as

1. E-Aadhar is a 12 digit individual identification number issued by the Unique 

Identification Authority of India on behalf of the Government of India.This 

number serve as a proof of identity and address, anywhere in India. Aadhaar 

letter received via India Post and e-Aadhaar downloaded from UIDAI website 

are equally valid.

2. E-JanSampark : Services & Information accessible to the common man in his 

locality to meet his basic need. This project is started by Chandigarh.

7.7.2.3 Disaster management

To manage disaster, is a very big challenge for the government as these are 

natural phenomena and are unpredictable. To deal with these disasters, many state 

government have started e-governance service for this. 

å� Project in this area are :

1. Chetana by the state of Bihar is a Disaster management system which has been 

started to deal with natural disasters such as flood and earthquake. 
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7.7.2.4 Land record management

By facilitating e-governance service in this area, millions of land records can be 

maintain in a very short time span.

å Projects in this area are :

1. Land Records Management System State Government of Punjab. 

2. Devbhoomi State Government of Uttarakhand. 

3. Bhu-Lekh  UP State Government of Uttar Pradesh. 

4. E-Dhara State Government of Gujarat.

7.7.2.5 Panchayat

Services provided by e-governance in this area are :

1. Issue of Birth/Death certificate.

2. Application for inclusion of name in Voter list. 

3. Conducting various welfare schemes for the poor and needy sections of the 

society. 

4. Preparing district wise planning, implementing those plan, and review for 

success. 

5. To provide wage employment to the needy from amongst the poorest section 

of the rural society. 

6. Rural water supply and sanitation.

å Various projects :

1. E-GramViswa Gram Project by Gujarat. 

7.7.3 E-governance in Health

Service provided by these projects are as :

1. Availability of medicines. 

2. Special health camps. 

3. Facilities at Anganwadi centers.

å Various projects are :

1. Hospital OPD Appointment : Hospital OPD Appointment System is welfare 

measure undertaken by Chandigarh Administration to make life of citizens 

simpler. 
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2. Another step taken ahead by PGI through its web portal for online registration 

and appointment with concerned doctors. 

3. Online Vaccination Appointment for International Traveler : Citizen centric 

application for the purpose of vaccination of the persons proceeding abroad 

and issuance of International Health Certificate.

7.7.4 E-governance in Education

Providing basic education (elementary, primary, and secondary) to children.

1. Providing computer education to children.

th th2. Results for 10  & 12  classes.

3. Information on eligibility for “Distribution of books” scheme.

å Various projects are :

1. Online Scholarship Management System such as Ashirwad portal by Punjab 

Government : It is meant for the purpose of distribution of scholarships and 

fees reimbursement.

Things to Remember
1. "Governance" means : the process of decision-making and the process by 

which decisions are implemented.

2. Good governance is the processes of making and implementing decisions.

3. Good governance follows the rule of law.

4. The establishment of e-Governance requires a good knowledge of the needs 

that exist in the society and that can be offered using ICT.

5. In E-Governance, government makes best possible use of internet technology 

to communicate and provide information to common peoples and 

businessman.

6. E-GOVERNANCE services can be shared between citizens, businessman, 

government and employees.

7. IRCTC (Indian Railway Catering and tourism Cooperation ltd.) Offers online 

rail ticket booking, and checking of ticket reservation status. 

8. Online Scholarship Management System such as Ashirwad portal by Punjab 

Government is the purpose of distribution of scholarships and fees 

reimbursement.
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Exercise
1. Multiple Choices :

 1. .................................................... .G2C stands for 

 (a) Government to cooperation  (b) Grievances to  cooperation 

 (c) Government to citizen (d) None of these

2. G2G stands for  .................................................... .

 (a) Government to Government (b) Get to Go

 (c) Gather to Go   (d) None of these

3. G2E stands for  .................................................... .

 (a) Grievance to employee (b) Government to employee

 (c) Government to environment (d) None of these

4. G2B stands for  .................................................... .

 (a) Government to Banks (b) Government to Businessmen

 (c)  Government to Business (d) None of these

5. IRCTC stands for  .................................................... .

 (a) Indian Railway Catering and tourism Cooperation ltd.

 (b) Indian Runway Catering and tourism Cooperation ltd.

 (c) Indian Railway Catering and travelling Cooperation ltd.

 (d) Indian Railway Cargo and tourism Cooperation ltd.

2. Short Answer Type Questions : 

1. What is E  governance ?

2. What are the two main objectives of e-governance ?

3. Write the area of E-governance in urban ?

4. Write the area of E-governance in rural ?

3. Long Answer Type Questions :

1. Write the main characteristics of Good Governance

2. Explain the four pillars of E-Governance

3. Explain the four models of e-governance 

4. Write about E-GOVERNANCE IN HEALTH and EDUCATION

5. Describe the history and development of E  governance.
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